Hart Scientific, Inc. (Hart) warrants this product to be free from defects in material and workmanship under normal use and service for a period as stated in our current product catalog from the date of shipment. This warranty extends only to the original purchaser and shall not apply to any product which, in Hart’s sole opinion, has been subject to misuse, alteration, abuse or abnormal conditions of operation or handling.

Software is warranted to operate in accordance with its programmed instructions on appropriate Hart products. It is not warranted to be error free.

Hart’s obligation under this warranty is limited to repair or replacement of a product which is returned to Hart within the warrant period and is determined, upon examination by Hart, to be defective. If Hart determines that the defect or malfunction has been caused by misuse, alteration, abuse or abnormal conditions or operation or handling, Hart will repair the product and bill the purchaser for the reasonable cost of repair. To exercise this warranty, the purchaser must forward the product after calling or writing Hart for authorization. Hart assumes NO risk for in-transit damage.

For service or assistance, please contact the manufacturer.

    Hart Scientific, Inc.
    799 East Utah Valley Drive
    American Fork, UT 84003-9775
    Phone: (801) 763-1600
    Fax: (801) 763-1010
    E-mail:

THE FOREGOING WARRANTY IS PURCHASER’S SOLE AND EXCLUSIVE REMEDY AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTY OR MERCHANTABILITY, OR FITNESS FOR ANY PARTICULAR PURPOSE OR USE. HART SHALL NOT BE LIABLE FOR ANY SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OR LOSS WHETHER IN CONTRACT, TORT, OR OTHERWISE.

Microsoft, MS-DOS, Windows, Windows for Workgroups, Windows 95, Windows 98, and Windows NT are either registered trademarks or trademarks of Microsoft Corporation.

Copyright © 2000, Hart Scientific, Inc. All rights reserved.
# Table of Contents

1 Introduction ......................................................... 1
   1.1 What is the LogWare Software? .............................. 1
   1.2 Features ...................................................... 1
   1.3 Requirements ................................................ 2
      1.3.1 Thermometer Requirements ............................ 2
      1.3.2 Communications Requirements ......................... 3
      1.3.3 Computer Hardware Requirements ..................... 3
      1.3.4 Computer Software Requirements ...................... 3
   1.4 Installation .................................................. 4
      1.4.1 Installing from CD ..................................... 4
      1.4.2 Installing from Floppy Diskettes (available upon request) ......................................................... 4
      1.4.3 Uninstalling the Software .............................. 5
   1.5 Regional Settings ............................................. 6
   1.6 Running LogWare .............................................. 6
      1.6.1 Getting Started ......................................... 6
      1.6.2 Running the LogWare Software ......................... 7
   1.7 Required .DLL and .OCX Files ............................... 9
   1.8 LogWare Main Display ....................................... 11
   1.9 Toolbar ....................................................... 12
      1.9.1 File Toolbar ............................................. 12
      1.9.2 Datalog Toolbar ......................................... 13
      1.9.3 Graph Toolbar ........................................... 13
      1.9.4 Tools Toolbar ........................................... 13
      1.9.5 Help Toolbar ............................................ 14

2 How To.... .......................................................... 15
   2.1 Using an I/R Dongle with LogWare .......................... 15
   2.2 Opening a Configuration File Automatically on Start-up .... 17
   2.3 Starting a Real-time Log Session Unattended (Delayed Start) . 19
   2.4 Stopping a Real-time Log Session Automatically .......... 20
   2.5 Downloading Logged Data From the Memory of a Thermometer ................................................................. 21
   2.6 Viewing Remaining Memory for Logging Data ............... 22
   2.7 Changing Thermometer and/or INFO-CON/Probe Settings ... 23
   2.8 Saving Thermometer and/or INFO-CON/Probe Settings to a Configuration File .............................. 24
   2.9 Synchronizing the Thermometer's Clock to the Computer ... 26
6.2.1 Statistics ................................................................. 67
6.3 Open Previously Logged Datafile ................................. 67

7 Graph Menu ................................................................. 71

7.1 Graph Settings ......................................................... 72
7.1.1 Titles ................................................................. 73
7.1.2 Axis ................................................................. 75
7.1.3 Fonts ................................................................. 78
7.1.4 Trends ............................................................... 79
7.1.5 Background ........................................................ 83
7.1.6 Legend .............................................................. 85
7.1.7 System .............................................................. 86
7.2 Restore Default Settings ........................................... 88
7.3 Trace Color ............................................................ 89
7.4 Zoom In ............................................................... 89
7.5 Restore (Zoom Out) .................................................. 90
7.6 Print Graph ............................................................ 90

8 Tools Menu ............................................................... 91

8.1 Synchronize Date/Time .............................................. 91
8.2 Write Labels .......................................................... 92
8.3 INFO-CON/Probe Settings ........................................ 93
8.4 Thermometer Settings .............................................. 98
8.5 Select Model .......................................................... 102
8.6 Enter Passcode ....................................................... 104
8.7 Calendar-Van Dusen Coefficients ................................. 105
8.8 High Temp. PRT Coefficients .................................... 106
8.9 IPTS-68 Coefficients ................................................. 107
8.10 ITS-90 Coefficients ................................................ 108
8.11 Thermistor Coefficients ........................................... 110

9 Window Menu ............................................................. 113

10 Help Menu ............................................................... 115

10.1 Technical Support ................................................... 115
10.2 About ................................................................. 116

11 Configuration and Other Files ................................. 117

11.1 Single Channel Configuration File ............................. 117
11.2 Alarms Configuration File ....................................... 117
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.3</td>
<td>Thermometer Configuration File</td>
<td>118</td>
</tr>
<tr>
<td>11.4</td>
<td>Channel Configuration File</td>
<td>118</td>
</tr>
<tr>
<td>11.5</td>
<td>Conversion Configuration Files</td>
<td>119</td>
</tr>
<tr>
<td>11.6</td>
<td>Output Files</td>
<td>119</td>
</tr>
<tr>
<td>11.7</td>
<td>Download Files</td>
<td>120</td>
</tr>
<tr>
<td>11.8</td>
<td>Alarm Log File</td>
<td>121</td>
</tr>
</tbody>
</table>
Figures and Tables

Figure 1  Shared Files Conflict Dialog ................................................. 8
Table 1  Required .DLL and .OCX Files .................................................. 9
Figure 2  9934 LogWare Main Display .................................................. 11
Figure 3  LogWare Toolbar ................................................................. 12
Figure 4  File Toolbar ..................................................................... 12
Figure 5  Datalog Toolbar ................................................................. 13
Figure 6  Graph Toolbar .................................................................. 13
Figure 7  Tools Toolbar .................................................................. 13
Figure 8  Help Toolbar .................................................................... 14
Figure 9  Model 2374 Infrared Dongle ............................................... 16
Figure 10 Text Import Wizard – Step 1 of 3 Dialog ......................... 27
Figure 11 Text Import Wizard – Step 2 of 3 Dialog ......................... 28
Figure 12 Output File Displayed in Spreadsheet .............................. 28
Figure 13 Chart of Output File ........................................................... 29
Figure 14 File Menu ....................................................................... 31
Figure 15 Default Settings Dialog ..................................................... 32
Figure 16 File|Defaults General Tab .................................................... 33
Figure 17 File|Defaults Folders Tab ....................................................... 34
Figure 18 Datalog Menu ................................................................. 37
Figure 19 Log Session Settings ............................................................ 37
Figure 20 Log Session Start Time ....................................................... 42
Figure 21 Alarm Settings Dialog ......................................................... 44
Figure 22 Delayed Start Date/Time Dialog ........................................ 47
Figure 23 Real-Time Log Session Window ....................................... 49
Figure 24 Download Menu ............................................................... 53
Figure 25 1522 Download Dialog ....................................................... 54
Figure 26 1522 Log Status Dialog ....................................................... 58
Figure 27 Downloaded Files Dialog ..................................................... 60
Figure 28 View Menu ...................................................................... 63
Figure 29 Alarms.log Dialog ............................................................. 64
Figure 30 Alarms Dialog ................................................................. 65
Figure 31 Output File Dialog ............................................................. 66
Figure 32 Statistics Dialog ............................................................... 67
Figure 33 Log File Dialog ............................................................... 68
Figure 34 Graph Menu ................................................................. 71
Figure 35 Graph Settings Dialog ....................................................... 72
Figure 36 Graph Settings - Titles Tab ................................................... 73
Figure 37 Graph Settings - Axis Tab ..................................................... 75
Figure 38 Graph Settings - Fonts Tab .................................................. 78
Figure 39 Graph Settings - Trends Tab ............................................... 79
Figure 40 Graph Settings - Background Tab ..................................... 83
Figure 41 Graph Settings - Legend Tab ................................................ 85
1 Introduction

1.1 What is the LogWare Software?

The Model 9934 LogWare Software is a real-time data logging, storage and analysis program designed specifically for use with Hart Scientific digital thermometers. LogWare automates the logging of data from a single channel or input.

LogWare is designed to work with the following Hart Scientific digital thermometers:

- 1502 “Tweener” Thermometer (2 styles)
- 1502A “Tweener” Thermometer
- 1503 “Tweener” Thermometer
- 1504 “Tweener” Thermometer
- 1521 LLK Handheld Thermometer
- 1522 LLL Handheld Datalogger

1.2 Features

The Model 9934 LogWare Software provides an easy-to-use Windows® interface to log, store and analyze data from Hart Scientific digital thermometers. LogWare also provides a method to download readings that are stored in the memory of thermometers that support this feature, such as the model 1522 LLL Handheld Datalogger. After being logged or downloaded, the readings are written to a file that can be opened by LogWare, spreadsheet or other analysis software.

LogWare’s data logging features include:

- Quick and easy configuration
- Ability to save and open setup configuration files
- Selectable sample interval from 1 second to 24 hours
- Selectable delayed start time/date for off-hours logging
- Selectable end log options (allows a log session to stop automatically after a specified time or a specified number of readings)
- Logs readings to ASCII text files that can then be opened, graphed and printed
- Graphs readings as they are being logged
- Maintains statistical data for logged readings
• Ability to set High and Low alarms
• Can play .WAV file or launch any other software package when an alarm trips (such as Pager software)
• Many user-customizable graph settings including alarm, statistical and trend lines

LogWare’s data analysis features include:
• Can open both real-time log files and downloaded files
• Spreadsheet-style grid to view all readings
• Graph that displays up to 32,767 readings at a time
• Graph zooming capability
• Statistical lines and calculations
• Printing graph and readings
• Can have multiple windows open simultaneously

LogWare also provides utilities which allow access to the following thermometer features (as applicable):
• Download logged data
• View log status
• Change log labels
• Synchronize date/time with computer
• Change thermometer-specific parameters (filter, resolution, units, calibration dates and constants, etc.)
• Change INFO-CON or probe-specific parameters (conversion type and coefficients, calibration dates, excitation current, etc.)

### 1.3 Requirements

The LogWare Software supports the Hart Scientific digital thermometer models as listed below. The communication and computer requirements are also listed.

#### 1.3.1 Thermometer Requirements

The LogWare Software is designed to work with the following Hart Scientific thermometers:

• 1502 “Tweener” Thermometer (2 styles)
• 1502A “Tweener” Thermometer


1.3.2 Communications Requirements

The instrument being used with LogWare must be connected to a COM (RS-232 serial) port on a computer using a “null modem” cable. (A “null modem” cable is a cable that effectively replaces two modems. Refer to the thermometer’s User Guide for more information on the cable or contact hart Scientific Customer Service to purchase a “null modem” cable.) The baud rate can be set from 300 baud to 9600 baud depending on the instrument. However, the instrument and computer baud rates must match.

1.3.3 Computer Hardware Requirements

The following minimum computer configuration is required to use the LogWare Software.

- IBM Compatible 486 PC or better with 8MB RAM (Pentium® class processor with 16MB RAM or more recommended)
- VGA monitor or better
- CD-ROM drive for installation (3.5” floppy diskettes available upon request)
- 1 – RS-232 Serial Communication Port (COM Port)

Minimum of about 8MB of disk space (for installation) - The program requires additional disk space to store the data as it is acquired.

1.3.4 Computer Software Requirements

The LogWare Software requires one of the following operating systems

- Windows® 95/98
- Windows® NT with SP4*

*Note: LogWare has only been tested on Windows® NT with Service Pack 4 installed.
1.4 Installation

A backup should always be made of your hard disk drive and registry before installing any software and all running applications should be closed.

Note: If this software has been previously installed on this computer, follow the Uninstalling the Software instructions below before proceeding!

1.4.1 Installing from CD

1. Insert the LogWare Software CD-ROM into your CD-ROM drive. The Setup program should run automatically.

2. Follow the on-screen instructions. The README file will be displayed. Read this file for important information that was not available when the manual was printed.

3. The software files are copied to the specified folder.

4. The installation creates a menu option in the Programs menu called Hart Scientific 9934. The program, help file and README icons are all located in this menu.

1.4.2 Installing from Floppy Diskettes (available upon request)

1. Insert Disk 1 of the LogWare Software into your floppy drive.

2. Select the Run option from the Start menu on the Task Bar.

3. In the dialog box that appears, type D:\SETUP.EXE (where D: is the drive corresponding to your floppy drive) and click the OK button.

4. Follow the on-screen instructions. The README file will be displayed. Read this file for important information that was not available when the manual was printed.

5. The software files are copied to the specified folder. Insert other disks when prompted.
6. The installation creates a menu option in the Programs menu called Hart Scientific 9934. The program, help file and README icons are all located in this menu.

1.4.3 Uninstalling the Software

The LogWare Software installation creates an entry for uninstallation in the Add/Remove Programs option in the Control Panel. To uninstall the software, follow the instructions below:

1. Open the Control Panel by selecting the Settings | Control Panel option from the Start menu.

2. In the Control Panel, double-click the Add/Remove Programs icon to open the Add/Remove Programs Properties dialog.

3. Select the Install/Uninstall tab.

4. In the list that appears on the lower half of the tab, locate and click on the 9934 LogWare entry.

5. Click the Add/Remove button.

6. Follow the on-screen instructions to remove the software.

Note: Removing this software does NOT delete any user files that were saved in the program folder (including output files, configuration files, and download files). These files must be removed manually using Windows® Explorer.

Note: You may receive one or more prompts to choose whether or not to remove a file from the system as the software is being uninstalled. Be careful not to remove a file that is required by another application. To be safe, you may wish to choose NOT to remove these files. If you are sure the files are not used by any other applications, they may be removed. For a list of files that this software installed to your system, see Section 1.7 Required .DLL and .OCX Files.

7. When finished uninstalling the software, close the Add/Remove Programs Properties dialog by clicking the OK button.
1.5 Regional Settings

LogWare recognizes and uses the regional settings such as the date, time and number formats as set in the Windows® Control Panel’s Regional Settings icon.

1.6 Running LogWare

1.6.1 Getting Started

The following information is intended to provide a brief overview on how to get the LogWare Software up and running quickly. For more detailed information, please refer to the following sections:

- Section 1.6.2, Running the LogWare Software
- Section 1.8, LogWare Main Display
- Section 4, Datalog Menu

To use this software:

1. Click the Start button and select Programs | Hart Scientific 9934 | 9934 LogWare.

2. The software will start with the Log Session Settings dialog displayed on top of the LogWare Main Display (see Section 4.1). If the Log Session Settings dialog is not displayed when the software starts, select the Setup option from the Datalog menu.

   **Note:** In order to make the Log Session Settings dialog appear when the software starts, check the “Show Log Session Settings dialog on start-up” check box on the General tab of the Defaults dialog.

To start a log session, fill in the information on the Log Session Settings dialog. The following information **must** be entered before a log session can start:

- Select the Model of the thermometer to use. Enter the Serial Number and select the Readings Scale from the available choices.
- Select the COM port to which the thermometer is connected and choose the baud rate.
- Power up the thermometer and make sure it is connected to the specified COM port. Click the Test Communication button to make sure LogWare can communicate with the thermometer.
• Choose the log interval (time between readings)

• Choose the appropriate end log option and set the other end log settings as required.

• To set a delayed start date/time, click the Delayed Start button and choose the appropriate date and time for the log session to begin. Otherwise, the log session will begin when the Start button is clicked.

• Select the trace color, enter the output filename and set the statistics options as desired.

• To configure alarms, click the Alarm Settings button and set the appropriate alarm settings as desired.

These settings can be saved to a configuration file by clicking the Save As button. If this configuration should be opened every time the software runs, click the Set as Default button.

After entering this information, click the Start button to start the log session.

1.6.2 Running the LogWare Software

To run the Model 9934 LogWare Software, click the Start button, then select Programs | Hart Scientific 9934 and click on the 9934 LogWare Software icon.

Every time this software is run, it checks to make sure that all of the required .DLL and .OCX files are found on your computer. If the software detects that an older file has replaced one or more of these files or that
the file is not found, the Shared Files Conflict dialog (Figure 1) appears detailing the problems found as shown below:

![Shared Files Conflict Dialog](image)

*Figure 1  Shared Files Conflict Dialog*

Every time you install any software on your computer, it is a good idea to make a backup of your important files, including all files in the \WINDOWS and \WINDOWS\SYSTEM (or \WINDOWS\SYSTEM32) folders. All boot files such as AUTOEXEC.BAT and CONFIG.SYS and the registry should also be backed up. Sometimes during the installation process, a file may be replaced with an older version that is not 100% compatible with the first. This may cause the software to perform unexpectedly or fail to run at all. Replacing a .DLL or .OCX file with a newer version does not usually cause any problems because these files are typically backward compatible. There are, however, exceptions to this rule.

If the Shared Files Conflict dialog is displayed when you run the software, a list of the files is shown in the Conflicting Files list. Select each of the files, one at a time, and read the information that appears in the bottom half of the dialog. Depending on the information given, you must decide
what to do. The software may continue to run without problems, however there is no guarantee of this. If some files are missing, the best option is usually to reinstall the software.

The .DLL and .OCX files are typically located in the \WINDOWS\SYSTEM (or \WINDOWS\SYSTEM32) folder. If you find it necessary to avoid conflicts, these files can be copied to the folder where the software was installed. Be sure to compare the files on your computer with the list of required .DLL and .OCX files.

After clicking the Continue button, or if there were no file conflicts, the LogWare Software Main Display is shown.

1.7 Required .DLL and .OCX Files

This software requires certain .DLL and .OCX files. All required files are shipped on the installation CD or diskettes. A list of these files and their required date stamp can be found in Table 1.

Table 1 Required .DLL and .OCX Files

<table>
<thead>
<tr>
<th>.DLL Files</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASYCFILT.DLL</td>
<td>03/08/1999</td>
</tr>
<tr>
<td>COMCAT.DLL</td>
<td>03/23/1999</td>
</tr>
<tr>
<td>COMCTL32.DLL</td>
<td>05/08/1998</td>
</tr>
<tr>
<td>COMDLG32.DLL</td>
<td>08/24/1996</td>
</tr>
<tr>
<td>H1522OPT.DLL†</td>
<td>01/14/2000</td>
</tr>
<tr>
<td>HALARMS.DLL†</td>
<td>01/14/2000</td>
</tr>
<tr>
<td>HARTCOMM.DLL</td>
<td>04/13/1999</td>
</tr>
<tr>
<td>HARTCONV.DLL</td>
<td>06/21/1999</td>
</tr>
<tr>
<td>HBBROWSE.DLL†</td>
<td>01/14/2000</td>
</tr>
<tr>
<td>HCHANNEL.DLL†</td>
<td>01/14/2000</td>
</tr>
<tr>
<td>HCNVRSNS.DLL†</td>
<td>01/14/2000</td>
</tr>
<tr>
<td>HCOMMDLG.DLL†</td>
<td>01/14/2000</td>
</tr>
<tr>
<td>HCOMMUN.DLL†</td>
<td>01/14/2000</td>
</tr>
<tr>
<td>HCOMPORT.DLL†</td>
<td>01/14/2000</td>
</tr>
<tr>
<td>HHELP.DLL†</td>
<td>01/14/2000</td>
</tr>
<tr>
<td>HINIFILE.DLL†</td>
<td>01/14/2000</td>
</tr>
<tr>
<td>HOUTFILE.DLL†</td>
<td>01/14/2000</td>
</tr>
<tr>
<td>HPRGRSS.DLL†</td>
<td>01/14/2000</td>
</tr>
</tbody>
</table>
### .OCX Files

<table>
<thead>
<tr>
<th>.OCX Files</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMCT32.OCX</td>
<td>05/07/1999</td>
</tr>
<tr>
<td>COMDLG32.OCX</td>
<td>05/07/1999</td>
</tr>
<tr>
<td>DWVSTP32.OCX</td>
<td>03/26/1999</td>
</tr>
<tr>
<td>MFTCOMCT2.OCX</td>
<td>05/07/1999</td>
</tr>
<tr>
<td>MFTCOMCTL.OCX</td>
<td>05/13/1999</td>
</tr>
<tr>
<td>MFTCOMM32.OCX</td>
<td>06/24/1998</td>
</tr>
<tr>
<td>MFTFLXGRD.OCX</td>
<td>05/07/1999</td>
</tr>
<tr>
<td>VSVIEW3.OCX</td>
<td>04/22/1998</td>
</tr>
</tbody>
</table>

### Other Files

<table>
<thead>
<tr>
<th>Other Files</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>STDOLE2.TLB</td>
<td>03/08/1999</td>
</tr>
<tr>
<td>WINSPOOL.DRV</td>
<td>08/24/1996</td>
</tr>
</tbody>
</table>

†These files are specific to this software and are unlikely to be used by other applications. When uninstalling this software, you may choose to remove these files from your system if prompted.

All other files are very likely to be used by other applications. When uninstalling this software, you may wish to choose **not** to remove these files from your system if prompted.
1.8 LogWare Main Display

The main display (Figure 2) consists of the menu bar, toolbar, a workspace area and a status bar.

![LogWare Main Display](image)

*Figure 2 9934 LogWare Main Display*

The menu bar allows access to the various features of the software. A general description of the options in each menu is given below:

- **File** – Open and save configuration files, change default settings, printing options, exit the software
- **Datalog** – Setup, Start, Stop and Close real-time log sessions
- **Download** – Download logged readings from a thermometer and view log status
- **View** – View alarm log and reading history during real-time log session and open previously logged data files
• **Graph** – Change graph settings, zoom in and out, and print the current graph
• **Tools** – Synchronize thermometer date/time, configure various thermometer and INFO-CON/probe settings
• **Window** – Rearrange and switch between open windows
• **Help** – Display help topics and About dialog

The toolbar allows quick access to the most common menu functions. The toolbar is divided into sections that correspond to related functions. Toolbar sections may be rearranged as desired by clicking on the vertical bar on the left side of the section and dragging it to the desired location.

The status bar indicates the function that the software is currently performing as well as the current system date and time.

**Note:** The date and time displayed are based on the computer’s clock settings and can be modified through the Windows® Control Panel. The date and time formats used can be changed by selecting the Regional Settings icon in the Control Panel.

### 1.9 Toolbar

The toolbar (Figure 3) provides quick access to many of the most common functions of the software. The toolbar is divided into sections that correspond to related menu options. Toolbar sections may be rearranged as desired by clicking on the vertical bar on the left side of the section and dragging it to the desired location.

![LogWare Toolbar](image)

**Figure 3** LogWare Toolbar

The following toolbars are available:

#### 1.9.1 File Toolbar

![File Toolbar](image)

**Figure 4** File Toolbar

- **New** – Create a new real-time log session configuration
- **Open** – Open a real-time log session configuration file
Save As – Save the current real-time log session settings to a configuration file

1.9.2 Datalog Toolbar

Setup – Setup a real-time log session
Start – Start a real-time log session
Stop – Stop a real-time log session
Close – Close a real-time log session
Mute All Alarms – Mute/Unmute all real-time log session alarms

1.9.3 Graph Toolbar

Graph Settings – Change graph settings, add trend lines, alarm lines, titles, captions, etc.
Zoom In – Zoom in to view a section of the graph
Restore (Zoom Out) – Zoom out to view entire graph

1.9.4 Tools Toolbar

Synchronize Date/Time – Synchronize thermometer’s date/time with computer
Write Labels – Change the labels associated with datalogging
INFO-CON/Probe Settings – Change settings associated with the INFO-CON connector or probe

Thermometer Settings – Change settings associated with the thermometer

1.9.5 Help Toolbar

![Help Toolbar](image)

*Figure 8*  Help Toolbar

Help – Open the help file
2  How To...

This section contains some “How to…” step-by-step instructions and other information on how to use the LogWare Software to perform certain tasks. The following topics are included:

- Using an I/R dongle with LogWare (see Section 2.1).
- Opening a configuration file automatically on start-up (see Section 2.2).
- Starting a real-time log session unattended (Delayed Start) (see Section 2.3).
- Stopping a real-time log session automatically (see Section 2.4).
- Downloading logged data from the memory of a thermometer (see Section 2.5).
- Viewing remaining memory for logging data (see Section 2.6).
- Changing thermometer and/or INFO-CON/probe settings (see Section 2.7).
- Saving thermometer and/or INFO-CON/probe settings to a configuration file (see Section 2.8).
- Synchronizing the thermometer’s clock to the computer (see Section 2.9).
- Importing logged data into a spreadsheet (see Section 2.10).

2.1  Using an I/R Dongle with LogWare

Some Hart Scientific thermometers, such as the Model 1522 LLL Handheld Datalogger, have a built-in I/R port that can be used to communicate with a computer. I/R ports have many advantages over standard RS-232 ports which include increased data transfer rate, greater flexibility and ease of use.

Hart thermometers with an I/R port use a proprietary protocol for communication. Because of this proprietary protocol, LogWare is not able to use I/R ports that are built into a computer. Instead, LogWare requires the use of an I/R dongle (Figure 9) which can be connected to a standard RS-232 port. No special software or drivers are required to use the dongle. All necessary communication protocols and drivers are built into
the LogWare software. To purchase an I/R dongle (Hart Model 2374), contact Hart Scientific Technical Support.

LogWare provides support for communicating over an I/R port with these thermometers. However, the support is limited to the following features:

- Downloading logged data from memory
- Checking log status
- Writing labels associated with logged data

LogWare does not support using the I/R port for real-time log sessions.

To use an I/R dongle with LogWare, follow these steps.

1. Locate a 9-pin or 25-pin COM (RS-232) port on the computer. Connect the I/R dongle to the port. If the COM port is a 25-pin port, use a 9-25 pin adapter to connect the dongle.

2. In the Download menu, select either the Download Logged Data option or the Log Status option. Or, in the Tools menu, select the Write labels option. The Select Model dialog is displayed (see Section 8.5).
3. Select the thermometer model to use. Then select the COM port to which the I/R dongle is connected.

**Note:** In the COM port drop down list, ports with the symbol ![Image](image.png) represent built-in I/R ports and **cannot be used!!**

4. Next, check the Use I/R Dongle check box. When this box is checked, the Baud Rate setting is ignored since the thermometers are fixed at 115,200 baud when using the I/R port.

5. To ensure the computer can communicate with the thermometer using the I/R port, place the I/R window of the thermometer in close proximity to the I/R dongle and make sure the path between the two is not obstructed (see the thermometer’s User Guide for details on the proximity requirements). Click the Test Communication button. If LogWare succeeds in communicating with the thermometer a success message is displayed. Otherwise, a failure message is displayed. In case of failure, check the following:

- The dongle is connected to the selected COM port
- The thermometer is powered up and operating
- The dongle is in range of the I/R port on the thermometer
- The path between the thermometer and dongle is not obstructed
- Shut the thermometer’s power off, then back on again

When communication succeeds, click the OK button to proceed to the appropriate dialog.

2.2 Opening a Configuration File Automatically on Start-up

LogWare was designed to be flexible with the thermometers that it can use and the features it supports. However, most users of LogWare will probably always use the same thermometer, scale, communication settings, log interval and channel and alarm settings to do all or most of their logging.

For this reason, LogWare allows real-time log session settings to be saved to a configuration file. Opening the configuration file restores the
settings eliminating the need to manually enter most of the information for a new log session.

Configuration files save the following information about a real-time log session:

- Thermometer model, serial number and readings scale
- Communications COM port and baud rate
- Log interval and End Log settings
- Channel trace color and filename
- Alarm and statistics settings

The delayed start date and time information is not saved in the configuration file. For more information on configuration files, please read Configuration Files.

In addition to allowing configuration files to be saved and opened, LogWare also allows one configuration file to be opened automatically every time LogWare runs. This configuration file can be specified in one of two ways:

- From the Defaults dialog (see Section 3.4.1)
- From the Log Session Settings dialog (see Section 4.1)

**Opening configuration file automatically using the Defaults dialog:**
- Select the Defaults option from the File menu (see Section 3.4.1).
- Select the General tab.
- Check the Show Log Session Settings dialog on start-up check box.
- Check the Load default configuration file automatically check box.
- Click the “…” (Browse) button to select the configuration file to open or type the path and filename in the Default configuration file box.
- Click the OK button to save the changes.

**Note:** The real-time log session settings must already be saved to a configuration file in order to accomplish these steps.

**Opening configuration file automatically using the Log Session Settings dialog:**
- Select the Setup option from the Datalog menu (see Section 4.1).
- Fill in all of the information on this dialog.
- Click the Alarm Settings button and fill in the desired alarm settings.
- Click the Set as Default button.
A prompt is displayed to save the settings to a configuration file. Enter the filename for this configuration file (use a descriptive name).

A prompt is displayed to confirm setting this configuration as the default configuration file. Click Yes.

Click the Close button to close the dialog.

Test this feature to make sure it works properly by closing LogWare and running it again. The Log Session Settings dialog should be displayed with all of the configuration information filled in. If the configuration file is not being loaded, check the Defaults dialog as explained above.

To disable opening the configuration file on start-up, uncheck the Load default configuration file automatically check box on the Defaults dialog.

### 2.3 Starting a Real-time Log Session Unattended (Delayed Start)

The main purpose of LogWare is to log data in real-time. Many times, the technician is present when a log session starts. However, sometimes it is necessary or desirable to start a real-time log session at off-hours when the technician is out.

LogWare has a feature called the Delayed Start which allows a real-time log session to start at a predefined date and time. By default, a real-time log session starts immediately when the Start button on the Log Session Settings dialog is clicked or when the Start option in the Datalog menu is selected.

**Setting the delayed start date and time for a real-time log session:**

- Select the Setup option from the Datalog menu to display the Log Session Settings dialog (see Section 4.1).
- Fill in the Thermometer settings and Communication settings information.
- Set the Log interval and choose the appropriate End Log settings.
- Click the Delayed Start button to display the Delayed Start Date/Time dialog.
- Choose the date and time that the real-time log session should start. The start date and time are with respect to the computer’s clock settings. Make sure the computer’s clock is accurate. Click the OK button to accept the selected date and time.
**Note:** To cause the real-time log session to start immediately when clicking the Start button after having set a delayed start date and time, click the Reset button.

- Fill in the Channels information to complete the setup process.
- Click the Start button on the Log Session Settings dialog.
- LogWare displays a message indicating the date and time the real-time log session will start.
- To cancel the delayed start, click the Cancel button at any time.

After a real-time log session ends, the delayed start time is reset so that the next real-time log session will start immediately when the Start button on the Log Session Settings dialog is clicked or when the Start option in the Datalog menu is selected. To set a new delayed start time for the next real-time log session, follow the steps above.

**Note:** Every effort has been made to make the real-time log session take its first reading at the selected date and time. However, due to the large variation in the speed at which different computers operate, the first reading may be one or more seconds later than the selected time (commonly known as “latency”). To compensate for this, try a few tests to determine the approximate latency in the computer being used and then adjust the start time accordingly by reducing the start time by the difference between the selected start time and the actual time of the first reading.

---

### 2.4 Stopping a Real-time Log Session Automatically

The main purpose of LogWare is to log data in real-time. Many times, the technician is present when a log session needs to be stopped. However, sometimes it is necessary or desirable to stop a real-time log session when the technician is busy with another task, or at off-hours when the technician is out.

The End Log feature of LogWare provides three methods for stopping a real-time log session:

- Manually, by the technician
- Automatically, after a specific number of readings
- Automatically, after a specific period of time

The first method, Manually, by the technician, is the default End Log setting.

**Stopping the real-time session automatically:**

- Select the Setup option from the Datalog menu to display the Log Session Settings dialog (see Section 4.1).
• Fill in the Thermometer settings and Communication settings information.
• Set the Log interval.
• If needed, select the appropriate delayed start date and time.
• Using the End Log drop down list, select the method to use to stop the real-time log session:
  - **By user** – Log session stops when the Stop option in the Datalog menu is selected
  - **After specified # of readings** – Log session stops automatically when number of readings specified have been logged
  - **After specified time** – Log session stops automatically after the specified time has elapsed
• Specify the End Log criteria by selecting either the number of readings or the elapsed time
• Fill in the Channels information to complete the setup process.
• Click the Start button on the Log Session Settings dialog to start the real-time log session.

### 2.5 Downloading Logged Data From the Memory of a Thermometer

Some thermometers that are supported by LogWare allow readings to be logged to the memory of the thermometer. LogWare provides a feature to download the logged readings from the memory of the thermometer and save them to a text file (or files) on the computer.

Currently, only the Model 1522 LLL Handheld Datalogger has this capability.

**Downloading readings from the memory of a thermometer to a text file (or files) on the computer:**

• Select Download Logged Data from the Download menu (see Section 5.1).

• The Select Model dialog is displayed (see Section 8.5). Select the thermometer model from which the readings are to be downloaded. Also, select the COM port to which the thermometer is connected and the baud rate to use. If using the I/R port, check the Use I/R Dongle check box.
Note: The 1522 LLL Handheld Datalogger has an I/R port which can be used to download readings. Using the I/R port requires an I/R dongle to be connected to a COM port on the computer. For more information, please read Section 2.1 Using an I/R dongle with LogWare.

- Make sure LogWare can communicate with the thermometer by clicking the Test Communication button.
- Click the OK button when communication is successful.
- The Download dialog is displayed. This dialog is specific to the options and features of the selected thermometer model.
- Select the appropriate download options and click the Download button to download the readings.
- Click the Close button to close the Download dialog when finished.

2.6 Viewing Remaining Memory for Logging Data

Some thermometers that are supported by LogWare allow readings to be logged to the memory of the thermometer. LogWare provides a feature that indicates how much of the thermometer’s memory is already used. Currently, only the Model 1522 LLL Handheld Datalogger has this capability.

Viewing the status of the thermometer’s log(s):

- Select Log Status from the Download menu (see Section 5.2).
- The Select Model dialog is displayed (see Section 8.5). Select the thermometer model from which the readings are to be downloaded. Also, select the COM port to which the thermometer is connected and the baud rate to use. If using the I/R port, check the Use I/R Dongle check box.

Note: The 1522 LLL Handheld Datalogger has an I/R port which can be used to download readings. Using the I/R port requires an I/R dongle to be connected to a COM port on the computer. For more information, please read Section 2.1 Using an I/R dongle with LogWare.

- Make sure LogWare can communicate with the thermometer by clicking the Test Communication button.
- Click the OK button when communication is successful.
- The Log Status dialog is displayed indicating how much of the thermometer’s memory is already used. This dialog is specific to the features of the selected thermometer model.
• Click the Close button to close the Log Status dialog when finished.

2.7 Changing Thermometer and/or INFO-CON/Probe Settings

LogWare provides a feature which allows many of the thermometer and INFO-CON/probe settings to be read in, viewed, modified and written back out to the thermometer. These settings include:

- Filter
- Resolution
- Thermometer calibration and recalibration dates
- Thermometer calibration constants
- Probe serial number
- Probe wires
- Probe calibration and recalibration dates
- Probe conversion type and calibration coefficients

Viewing, modifying and writing the new settings to the thermometer:

- Select Thermometer Settings from the Tools menu (see Section 8.4).
- The Select Model dialog is displayed (see Section 8.5). Select the thermometer model from which the settings are to be read in. Also, select the COM port to which the thermometer is connected and the baud rate to use.
- Make sure LogWare can communicate with the thermometer by clicking the Test Communication button.
- Click the OK button when communication is successful.
- All thermometer and INFO-CON/probe settings are then read in and displayed in the Thermometer Settings dialog.

Note: The controls for settings which do not apply to the selected thermometer are disabled.

- Any of the settings can be modified at this time. All passcode protected settings are indicated in RED. These settings can be modified freely but will not be written back to the thermometer without the correct passcode being entered when prompted.
• To view or modify the INFO-CON/probe settings, select the appropriate channel from the Channels list and click the Channel Settings button to display the Channel Settings dialog.

• All thermometer and INFO-CON/probe settings can be saved to a configuration file by clicking the Save As button. To read in a configuration file containing thermometer and INFO-CON/probe settings, click the Open button. Thermometer configuration files have a .THM extension.

  Note: Thermometer configuration files are specific to each thermometer model. LogWare does not allow a thermometer configuration file for a 1502 to be opened when working with a 1521, etc. Therefore, when saving thermometer configuration files, include the thermometer model number in the filename so that the contents of the file are known.

• To write any changes that have been made back out to the thermometer, click the OK button. If any of the passcode protected settings were changed, the Enter Passcode dialog is displayed (see Section 8.6). The correct passcode MUST be entered in order for the new settings to be properly written to the thermometer.

  Note: LogWare cannot verify that the correct passcode was entered except on the model 1522 LLL Handheld Datalogger. If an incorrect passcode was entered, LogWare continues and attempts to write the new settings, however the thermometer will not accept the new settings.

• To close the Thermometer Settings dialog without writing the settings back out to the thermometer, click the Cancel button.

2.8 Saving Thermometer and/or INFO-CON/Probe Settings to a Configuration File

LogWare provides a feature which allows many of the INFO-CON/probe settings to be read in, viewed, modified and written back out to the thermometer. These settings include:

• Probe serial number
• Probe wires
• Probe calibration and recalibration dates
• Probe conversion type and calibration coefficients
Viewing, modifying and writing the new settings to the thermometer:

- Select INFO-CON/Probe Settings from the Tools menu (see Section 8.3).

- The Select Model dialog is displayed (see Section 8.5). Select the thermometer model from which the settings are to be read in. Also, select the COM port to which the thermometer is connected and the baud rate to use.

- Make sure LogWare can communicate with the thermometer by clicking the Test Communication button.

- Click the OK button when communication is successful.

- All INFO-CON/probe settings are then read in and displayed in the Channel Settings dialog.

  **Note:** The controls for settings which do not apply to the selected thermometer are disabled.

- Any of the settings can be modified at this time. All passcode protected settings are indicated in **red**. These settings can be modified freely but will not be written back to the thermometer without the correct passcode being entered when prompted.

- All INFO-CON/probe settings can be saved to a channel configuration file by clicking the Save As button. To read in a channel configuration file containing INFO-CON/probe settings, click the Open button. Channel configuration files have a `.CHN` extension.

  **Note:** Channel configuration files are specific to each thermometer model. LogWare does not allow a channel configuration file for a 1502 to be opened when working with a 1521, etc. Therefore, when saving channel configuration files, include the thermometer model number in the filename so that the contents of the file are known.

- To write any changes that have been made back out to the thermometer, click the OK button. If any of the passcode protected settings were changed, the Enter Passcode dialog is displayed (see Section 8.6). The correct passcode MUST be entered in order for the new settings to be properly written to the thermometer.

  **Note:** LogWare cannot verify that the correct passcode was entered except on the model 1522 LLL Handheld Datalogger. If an incorrect passcode was entered, LogWare continues and attempts to write the new settings, however the thermometer will not accept the new settings.
• To close the Channel Settings dialog without writing the settings back out to the thermometer, click the Cancel button.

2.9 **Synchronizing the Thermometer’s Clock to the Computer**

Most of the thermometers supported by LogWare have an internal clock. LogWare provides a feature to synchronize the thermometer’s clock with the clock on the computer.

**Note:** LogWare itself does not use the clock on the thermometer at all. All dates and times associated with readings logged by LogWare use the current date and time according to the computer’s clock.

Before synchronizing the thermometer’s clock, make sure the computer’s clock is accurate. Use the Windows® Control Panel to adjust the date and time as necessary.

**Synchronizing the thermometer’s clock with the computer’s clock:**

• Select Synchronize Date/Time from the Tools menu.

• The Select Model dialog is displayed (see Section 8.5). Select the appropriate thermometer model. Also, select the COM port to which the thermometer is connected and the baud rate to use.

• Make sure LogWare can communicate with the thermometer by clicking the Test Communication button.

• Click the OK button when communication is successful.

  **Note:** If the date and/or time setting on the selected thermometer’s clock is passcode protected, the Enter Passcode dialog is displayed (see Section 8.6). Enter the passcode and click the OK button to continue. If the passcode is not known, click the Cancel button to abort setting the thermometer’s clock.

• LogWare attempts to set the thermometer’s clock to match the clock on the computer.

  **Note:** LogWare cannot verify that the correct passcode was entered except on the model 1522 LLL Handheld Datalogger. If an incorrect passcode was entered, LogWare continues and attempts to write the new settings, however the thermometer will not accept the new settings.
2.10 Importing Logged Data into a Spreadsheet

The data logged by LogWare is saved into ASCII text files referred to as output files. These files can be opened and graphed by LogWare by selecting the Open Previously Logged Data File option from the View menu.

However, these files may also be imported into spreadsheet software such as Microsoft® Excel for graphing or analysis.

**Importing an output file into Excel:**

**Note:** This example uses Microsoft® Excel 97. These steps may not apply if using a different version of Excel or another spreadsheet software package.

- In Excel, select the Open option from the File menu to display the Open dialog.
- In the Files of type box at the bottom of the open dialog, select the Text Files option.
- Navigate to the folder where the output file is located. Select the output file to open and click the Open button.
- The Text Import Wizard – Step 1 of 3 dialog appears, Figure 10.

![Figure 10 Text Import Wizard – Step 1 of 3 Dialog](image)

- Make sure the Original data type option is set to Delimited. If the thermometer and probe information is not needed, set the Start import at
row option to row 8 or the first row containing the logged readings. Set the File Origin option to Windows (ANSI) and click the Next > button.

- The Text Import Wizard – Step 2 of 3 dialog appears, Figure 11.

![Text Import Wizard – Step 2 of 3 Dialog](image)

**Figure 11** Text Import Wizard – Step 2 of 3 Dialog

- In the Delimiters box, select the Tab and Space options. Make sure the Treat consecutive delimiters as one check box is checked and click the Finish button.

- The output file is displayed in the spreadsheet. Resize the columns so the contents of each cell are visible.

- Select the Date, Time, and Reading columns by clicking on the gray column headers labeled A, B, C and D as shown in Figure 12.

![Output File Displayed in Spreadsheet](image)

**Figure 12** Output File Displayed in Spreadsheet

- From the Insert menu of Excel, select the Chart option.
• The Chart Wizard – Step 1 of 4 – Chart Type dialog is displayed.
• In the Chart type list, select Line and click the Finish button.
• The graph should be displayed as shown in Figure 13.

Figure 13  Chart of Output File

• Format and size the graph as desired.
# 3 File Menu

The File menu (Figure 14) provides options for creating a new configuration, opening an existing configuration file, saving a configuration file, setting up program defaults, setting up the printer, printing, and exiting the program.

![File Menu](image)

**Figure 14  File Menu**

## 3.1 New

The New menu option should be selected when a new configuration needs to be created. When this option is selected, the user must confirm resetting all existing configuration settings before starting a new configuration. Resetting the configuration causes all thermometer, communications, log interval, channel, alarm and statistics settings to be reset. If the user chooses not to reset all existing settings, this process is aborted and no changes are made.

If the user chooses to reset all existing settings, the Log Session Settings dialog is displayed and a new configuration can be started.

## 3.2 Open

The Open menu option allows a previously saved configuration file containing test, thermometer, channel, alarm, statistics and conversion settings.

Selecting the Open menu option displays the Open Single Channel Configuration File dialog. Select the configuration file that contains the settings that match the instrument from which you wish to collect data. Then
click the Open button to open the configuration file. The Log Session Settings dialog will be displayed with the current settings.

### 3.3 Save As

Selecting the Save As menu option displays the Save Single Channel Configuration File As dialog. Enter a descriptive, unique filename that identifies the current configuration being saved to the file. You may want to include the thermometer model number and serial number. This filename can be up to 256 characters in length.

### 3.4 Defaults

The Defaults menu option displays the Default Settings dialog (Figure 15) and allows the user to set default settings by selecting one of two tabs: General or Folders. The General tab consists of miscellaneous settings for the software. The Folders tab consists of the locations of the configuration, output, and download files. The settings and selections entered on these tabs determine the behavior of the software.

![Default Settings Dialog](image)

*Figure 15  Default Settings Dialog*

Click the OK button to accept the current settings and close this dialog. Click the Cancel button to discard any changes you have made.
Click the Help button to display the appropriate help topic for this dialog.

3.4.1 General

The General tab (Figure 16) consists of miscellaneous settings for the software.

![General Settings](image)

Figure 16  File|Defaults General Tab

The settings on this tab are:

**Remember window positions and settings**

This option is used to make sure that dialogs and windows always appear in the same location on the screen every time they are displayed. If checked, dialogs and windows appear in the same position they were in when last closed. Otherwise, dialogs and windows always appear in the same place on the screen, regardless of their position when last closed.

**Show Log Session Settings dialog on start-up**

This option is used to specify whether or not the Log Session Settings dialog is displayed every time the software runs. If checked, the Log Session Settings dialog is displayed. Otherwise, this dialog is not displayed.
If this option is selected, the Load default configuration file automatically option is enabled. Checking this option allows a configuration file to be specified in the Default configuration file box below. If a configuration file is specified, it will be loaded every time the software runs. Use the “…” (Browse) button to locate the configuration file to load or type the path and filename into the box.

Click the OK button to accept the current settings and close this dialog. If the Load default configuration file automatically check box is checked, a valid configuration file must be specified. If this file does not exist, a message is displayed and the dialog will not close. Please select an existing configuration file.

Click the Cancel button to discard any changes you have made.

Click the Help button to display the appropriate help topic for this dialog.

### 3.4.2 Folders

The Folders tab (Figure 17) consists of the locations of the configuration, output, and download files.

![Figure 17 File|Defaults Folders Tab](image)

These folders default to specific subfolders of the folder where the software is installed. The default subfolder names are as follows:
Default folder for configuration files

This is the default folder, `<Drive>:\<AppFolder>\Config`, that is selected when the Open and Save As dialogs are displayed for opening and saving configuration files. For more information on configuration files, see Section 11 Configuration Files.

Default folder for output files

This is the default folder, `<Drive>:\<AppFolder>\Output`, where the output files from a real-time log session are written. Output files contain the data that was collected during a real-time log session. For more information on output files, see Section 11.6 Output Files.

Default folder for downloads

This is the default folder, `<Drive>:\<AppFolder>\Download`, that is selected when downloading data from thermometers that support this capability. Downloaded files contain data that the thermometer stores in memory. For more information on download files, see Section 11.7 Download Files.

Note: If the software is installed using the default settings, the “<Drive>:\<AppFolder>“ mentioned above refers to the following folder: C:\Program Files\Hart Scientific\9934 LogWare\. Otherwise, this path is the path to which the software was originally installed.

To change the default folder for any of these options, either type the path into the appropriate box or select the “…” (Browse) button to browse for an existing folder.

Note: If the folder does not already exist, the path must be typed into the box provided. If the folder does already exist, use the “…” (Browse) button to select it.

Click the OK button to accept the current settings and close this dialog.

Click the Cancel button to discard any changes you have made.

Click the Help button to display the appropriate help topic for this dialog.

3.5 Print Setup

Selecting the Print Setup menu option displays the Windows® Print Setup dialog. Select the settings you wish to change and click the OK button.

Note: The graph is always printed in a Landscape orientation regardless of the default orientation setting of the printer.
Select the Cancel button to discard any changes you have made.

3.6 Print

The Print menu option is only enabled when acquiring or analyzing data. Use this option to print readings and graphs.

The Print menu option has a submenu which consists of two options – Readings and Graph.

When printing the readings or graph, the information is sent to the current printer. To change the current printer, use the Print Setup menu option.

3.6.1 Readings

The Print | Readings menu option is used to print the data located in the current output file, which consists of the date and time each reading was taken, the reading and scale, and some alarm information. This file also contains some information about the thermometer and probe that were used to collect the data and the alarm settings (if applicable).

When logging real-time data, selecting the Print | Readings menu option prints all of the readings that have been taken up until the time this option is selected.

When viewing previously logged data, all readings are printed.

3.6.2 Graph

The Print | Graph menu option is used to print the current graph. This menu option performs the same task as selecting the Print Graph menu option from the Graph menu.

3.7 Exit

Select the Exit menu option from the File menu to close the software.

If any changes have been made to the configuration, the user is prompted to save the settings.
4 Datalog Menu

The Datalog menu (Figure 18) provides options for setting up a real-time log session, starting, stopping and closing a real-time log session and muting all alarm events.

![Datalog Menu](image)

**Figure 18** Datalog Menu

4.1 Setup Log Session

The Setup menu option displays the Setup Log Session (Figure 19) dialog. This dialog allows a real-time log session to be configured.

![Log Session Settings](image)

**Figure 19** Log Session Settings
4.1.1 Thermometer Settings

To start a real-time log session, the software must know what thermometer it is logging data from. Select the thermometer’s model number from the Model drop down list.

Enter the serial number of the thermometer in the Serial Number box. The serial number and the model number are both written to the header of the output file to indicate the instrument that was used to log the data.

Select the scale for the readings for this log session using the Readings Scale drop down list. The Readings Scale drop down list only displays the scales that are supported by the selected thermometer. To use the scale that the thermometer is currently set to, select the <Keep Existing> option.

4.1.2 Communication Settings

Select the COM port to which the thermometer is connected. This software expects to communicate with the thermometer via an RS-232 serial connection. Most laptop and desktop computers have at least one 9-pin or 25-pin COM port. Refer to your computer’s owner’s manual if you are unable to locate or identify a COM port on your computer.

Note: All Hart Scientific instruments require a “null modem” cable to interface with a computer. Please refer to the thermometer’s User Guide for more information on this type of cable.

Each COM port is accompanied by a symbol that reflects the current state of the COM port as follows:

- **COM ports with this symbol are available on this computer and can be selected.**

- **COM ports with this symbol are virtual COM ports used to interface with an I/R port. This software does not support using COM ports with this associated symbol.**

- **The COM port with this symbol is currently being used by this software.**

- **COM ports with this symbol are in use by another application and cannot be used by this software at this time.**
Select the baud rate that should be used to communicate with the thermometer. The available choices are determined by the baud rates supported by the selected thermometer.

**Note:** The thermometer and this software must both be set to the same baud rate in order to communicate successfully. Please refer to the thermometer’s User Guide for more information on setting the baud rate of the thermometer.

Once the thermometer and communication settings have been selected, click the Test Communication button to attempt to establish communication with the thermometer and verify that the proper thermometer model is selected. If the software succeeds in communicating, a success message is displayed.

If the software is not able to successfully establish communication with the thermometer or if the software determines that the selected model does not match the model of the connected thermometer, a failure message is displayed indicating the reason for the failure. In case of failure, check to make sure that:

- The communication cable is connected to the thermometer and the selected COM port
- The thermometer is powered up and operating
- The correct type of cable (null modem) is being used
- The thermometer is set to operate at the selected baud rate

### 4.1.3 Log Settings

LogWare supports logging real-time data at intervals from 1 second to 24 hours. Select the desired interval using the Interval – Once every box.

**Note:** The maximum sample rate for Hart Scientific thermometers is one reading per second. Although every attempt is made, selecting a one second sample interval in this software does not guarantee that one reading will be taken every second (because of processing overhead and calculations that this software must perform between each reading). Typical tests have shown that, on average, this software can acquire about 9 readings every 10 seconds on a Pentium® class computer. Slower computers may not be able to log data at this rate.

If the real-time log session should automatically stop after a certain number of readings or after a specific amount of time, select the appropriate options from the End Log drop down list and specify the number of readings or time in the After boxes. If the real-time log session should continue until it is explicitly stopped, select the By User option in the End Log drop down list.
LogWare is capable of starting a real-time log session at a future date and/or time for unattended operation. The box to the right of the Delayed Start and Reset buttons indicate when the log is scheduled to start.

To start the real-time log session at a future date and/or time, click the Delayed Start button. The Delayed Start Date/Time dialog is displayed. The delayed start date and time will be displayed in the box to the right of the Delayed Start and Reset buttons.

**Note:** Every effort has been made to make the real-time log session take its first reading at the selected date and time. However, due to the large variation in the speed at which different computers operate, the first reading may be one or more seconds later than the selected time (commonly known as “latency”). To compensate for this, try a few tests to determine the approximate latency in the computer being used and then adjust the start time accordingly by reducing the start time by the difference between the selected start time and the actual time of the first reading.

To start a real-time log session immediately when the Start button is clicked on this dialog, click the Reset button. This will ignore any delayed start date/time and the log session will start when the Start button is clicked. The box to the right of the Delayed Start and Reset buttons indicates that the log session will start immediately.

### 4.1.4 Channel Settings

The Channels list displays an item for every channel on the selected thermometer. Currently, LogWare only supports thermometers with a single channel. To specify settings for a channel, click on the appropriate item in the Channels list.

Select the color to use for the trace on the graph using the Trace Color drop down list.

Enter the name of the output file that the logged data for the selected channel should be saved to in the Filename box. Choose a descriptive filename that identifies the data contained in the file. LogWare automatically appends a .TXT extension on the end of the filename. The name of the output file is also used as the channel “label”. The channel label is a descriptive identifier assigned to a channel to give meaning to the readings being logged on that channel, instead of using only the channel number. By default, the filename is set to Channel N.txt (where N is the channel number).

Output files are written to the folder specified on the File | Defaults Folders tab. To change the folder where the output file will be saved for this log session, click the “…“ (Browse) button on the right side of the
Filename box. The Windows® Save As dialog is displayed. Navigate to the desired folder and click the OK button.

Check the Overwrite existing file check box if this output file should overwrite any existing file with the same name in the selected folder. If this box is not checked, this software will display a prompt if a file with the same name exists and allow the filename for this output file to be changed. It is recommended that this check box NOT be checked to prevent accidentally overwriting output files.

LogWare supports configuring low and high alarms for each channel. Alarms can be used to indicate readings that are out of a specified tolerance or to trigger an event. To configure alarms for the selected channel, click the Alarm Settings button. The Alarm Settings dialog is displayed (see Section 4.6).

To display the statistics for the selected channel, check the Show statistics check box. Statistical data is maintained for each channel regardless of whether it is being displayed or not. During a real-time log session, each statistical datum can be enabled or disabled independent from the others. See Section 4.8, Real-time Log Session for more details.

### 4.1.5 Open and Save As

Click the Open button to display the Windows® Open dialog to open a previously saved configuration file which contains test settings information. Click the Save As button to display the Windows® Save As dialog to save the current settings you have selected to a configuration file.

**Note:** For more information on configuration files, see Section 11 Configuration Files.

### 4.1.6 Set as Default

The current configuration can be set as the default configuration by clicking the Set as Default button. The default configuration is loaded automatically on start-up. The configuration must be saved to a file in order to be set as the default configuration. If the current settings have not been saved, the Windows® Save As dialog appears. Enter a descriptive filename and click OK to save the file. This configuration file will then be set to the default. For more default configuration file settings, see Section 3.4.1 General tab.

When all information has been entered, click the Start button to initiate the real-time log session. If no delayed start date and time were speci-
fied, the real-time log session starts immediately. If a start date and time were set using the Delayed Start button, the following dialog appears:

![Log Session Start Time](image)

*Figure 20  Log Session Start Time*

The log session will begin automatically on the date and time indicated. Click the Cancel button to abort starting the log session.

Click the Close button to close the Log Session Settings dialog without starting a log session to access other features of the software. All settings are remembered and the log session can be started at any time by selecting the Start option in the Datalog menu.

Click the Help button to display the appropriate help topic for this dialog.

### 4.2 Start Log Session

The real-time log session starts immediately when the Start menu option is selected if a delayed start date and time were not specified.

If a delayed start date and time were specified, LogWare performs some initial tasks to prepare to start the log session, then displays the Log Session Start Time dialog (Figure 20).

The log session will begin automatically on the date and time indicated. Click the Cancel button to abort starting the log session.

**Note:** Every effort has been made to make the real-time log session take its first reading at the selected date and time. However, due to the large variation in the speed at which different computers operate, the first reading may be one or more seconds later than the selected time (commonly known as “latency”). To compensate for this, try a few tests to determine the approximate latency in the computer being used and then adjust the start time accordingly by reducing the start time by the difference between the selected start time and the actual time of the first reading.
4.3 Stop Log Session

The Stop option in the Datalog menu can be used to stop a real-time log session at any time, regardless of whether or not the session was configured to stop automatically at a specified time or number of readings.

When the log session is stopped, a message is displayed asking if the Real-Time Log Session window should be closed or not. Clicking Yes closes the window so that a new log session can start. Clicking No leaves the current log session window open.

While the window is still open, the graph, readings history and alarm log files can be viewed and printed (see View menu and File menu). Also, the graph can be customized by selecting the Graph Settings option from the Graph menu.

Also, up to 8 previously logged data files can be opened while the real-time log session window is still open (see Section 6.3 Open Previously Logged Data File).

4.4 Close Log Session

Use the Close option in the Datalog menu to close the current Real-Time Log Session window.

Select the Stop option from the Datalog menu to stop the log session before it can be closed.

Only one real-time log session can be open and active at a time.

After a real-time log session has been stopped by selecting the Stop option from the Datalog menu, the log session can be closed. The current real-time log session MUST be closed before a new real-time log session can start.

To close the current Real-Time Log Session window, select Close from the Datalog menu.

4.5 Mute All Alarms

The Mute All Alarms option in the Datalog menu allows the user to prevent alarm events from occurring while logging real-time data. Alarms can be muted by selecting Mute All Alarms from the Datalog menu or by selecting the Mute button on the toolbar. When the alarms are muted, a red X appears through the alarms icon and the menu option displays a check mark. Otherwise, the alarms icon appears without the X and no check mark appears next to the menu option.
Muting alarms does not prevent entries from being written to the alarm log file. It also does not prevent alarm state information from being displayed in the Channels box on the Real-Time Log Session window while logging real-time data.

4.6 Alarm Settings

The Alarm Settings dialog (Figure 21) is used to configure low and/or high alarms for the selected channel. The current Low Alarm or High Alarm settings can be changed by selecting the appropriate tab.

![Alarm Settings Dialog]

When logging real-time data, an alarm log is maintained. Every time a reading trips either the low alarm or high alarm, an entry is written to the alarm log indicating the channel, date, time and reading value that tripped the alarm. An entry is also written to the alarm log every time an alarm is reset.
Low Alarm

The Low Alarm setting allows the user to specify what event should occur if the readings on the currently selected channel ever drop below the value entered in the Value box on the Low Alarm tab. To configure the low alarm, select the Low Alarm tab and select the appropriate options for this alarm.

High Alarm

The High Alarm setting allows the user to specify what event should occur if the readings on the currently selected channel ever rise above the value entered in the Value box on the High Alarm tab. To configure the high alarm, select the High Alarm tab and select the appropriate options for this alarm.

Enable alarms for this channel

To enable an alarm, check the 'Enable alarms for this channel' check box on the appropriate tab. The low and high alarms can be enabled/disabled independently of each other. When this check box is unchecked, all other controls on this dialog are disabled.

Value

Enter the reading value that is needed to trip the alarm. The value is required if an alarm is set. The readings scale of the value is displayed if the Readings Scale on the Log Session Settings dialog is not set to '<Keep Existing>'. Otherwise, this value will be in the current scale of the thermometer when the real-time log session begins.

Select the Event for This Alarm

Select the event that should occur when the alarm trips. The choices are:

- No event
- System Beep
- Display message and stop graphing/acquisition
- Play .WAV file
- Launch .EXE file

If either the Play .WAV file or Launch .EXE file is selected, the Path and Filename box and Browse button are enabled and the user must enter or select a filename. Select the Browse button to find and select a file. The Test button is enabled once the Path and Filename box is filled in. Select
the Test button to make sure the software can play or launch the file you have selected.

**Note:** The file entered in the Path and Filename box MUST exist! When the OK button is clicked, this software searches for the file. If it is not found, a warning message is displayed and the software will not continue. Be careful when selecting a file that resides on a network resource. The resource must be available when acquiring data to ensure the event occurs properly.

The Launch .EXE file option can be used to launch any application on the computer such as Pager software which could be configured to dial a phone number automatically and transmit a fixed message to a pager indicating that an alarm has tripped.

**Note:** It is not recommended that the Launch .EXE file option (especially in conjunction with the After every update option) be used until the user is familiar with how this feature works. Unless the .EXE file terminates itself automatically or limited to a single instance, this software will continue to launch new instances of the .EXE file, possibly causing the computer to run out of resources and even crash.

**When Should This Event Occur?**

Select when the specified event should occur. The choices are:

- Only once when the alarm value is exceeded
- After every update

If the Only once when the alarm value is exceeded option is selected, the chosen event will occur on the first reading that trips the alarm. Subsequent readings that also exceed the alarm value will not cause the event to occur again until one or more readings are taken that are back within the alarm value (alarm reset).

If the After every update option is selected, every reading that is taken that exceeds the alarm value causes the event to happen again.

**Open and Save As**

Select the Open button to display the Windows® Open dialog to open a previously saved configuration file which contains alarm information. Select the Save As button to display the Windows® Save As dialog to save the settings you have selected to a configuration file.

**Note:** For more information on configuration files, see Section 11 Configuration Files.

Select the OK button to accept the current settings and close this dialog.
Select the Cancel button to discard any changes you have made.
Select the Help button to display the appropriate help topic for this dialog.

4.7 Delayed Start Date/Time

The Delayed Start Date/Time dialog (Figure 22) allows the delayed start date and time for the real-time log session to be selected. When this dialog is displayed, the delayed start date/time is set to the current date and time according to the computer's clock.

![Delayed Start Date/Time Dialog]

**Figure 22** Delayed Start Date/Time Dialog

**Start log session on this date**

Select the date that the real-time log session should start using the calendar. To change months, click the left and right arrow buttons on the far left and right sides. To change the year, click on the displayed year at the top of the calendar and the up/down buttons will appear immediately to the right of the year. Use the up and down buttons to change the year. To select the day, simply click on the appropriate number on the calendar. The selected date is displayed above the calendar.

**At this time**

Select the hours, minutes, and seconds that the real-time log session should start using the At this time box. Click on the hours, minutes or seconds portion in the box and either type or use the up/down buttons on the right side of the box to change the value.
Current Date and Time

The Current Date and Time box displays the current date and time according to the computer's clock. If these settings are incorrect, adjust your computer's clock using the Windows® Control Panel.

After you have selected the appropriate date and time, select the OK button. If the date and time you have selected have already passed, a prompt is displayed and a future date and time must be selected.

Note: Every effort has been made to make the real-time log session take its first reading at the selected date and time. However, due to the large variation in the speed at which different computers operate, the first reading may be one or more seconds later than the selected time (commonly known as “latency”). To compensate for this, try a few tests to determine the approximate latency in the computer being used and then adjust the start time accordingly by reducing the start time by the difference between the selected start time and the actual time of the first reading.

Click the Cancel button to discard any changes and close this dialog.

Click the Help button to display the appropriate help topic for this dialog.

4.8 Real-Time Log Session

The Real-Time Log Session window (Figure 23) is displayed when a
real-time log session starts by selecting the Start option from the Datalog menu or by clicking the Start button on the Log Session Settings dialog.

LogWare was designed to communicate with only one thermometer at a time. Therefore, only one real-time log session can be running at a time.

In order to optimize the logging of readings, many menu options are disabled during a real-time log session. Of course, once a real-time log session is running, none of the settings can be changed, including the readings scale, alarm settings and events, and communication settings. Also, the Download menu options and Tools menu options are disabled, as well as the Open Previously Logged Data File option in the View menu.

If LogWare was configured to automatically stop logging data after a specific number of readings or after a specified amount of time, data will continue to be logged at the specified log interval until that condition is met. The Statistics box in the upper right corner of the Real-Time Log Session window displays the number of readings taken thus far and the elapsed time since logging started.

The real-time log session can be stopped manually at any time regardless of whether or not the log was configured to stop automatically by se-
lecting the Stop option from the Datalog menu or by clicking the Stop icon on the toolbar.

Once the real-time log session has been stopped, the output file which contains all of the logged readings can be opened by selecting the Open Previously Logged Data File option from the View menu.

**Note:** Be aware that selecting any menu option while a real-time log session is running may cause the measurement process to halt temporarily until the menu is closed or the dialog that is displayed is closed! Also, running other applications on the computer while logging real-time data, especially those that require a lot of processing time or that access the disk frequently, may cause the measurement process to halt temporarily while the other application is busy. It is recommended that, once a real-time log session is started, the software and the computer be left alone to log the data without interruption.

**Note:** The maximum sample rate for Hart Scientific thermometers is one reading per second. Although every attempt is made, selecting a one second sample interval in this software does not guarantee that one reading will be taken every second (because of processing overhead and calculations that this software must perform between each reading). Typical tests have shown that, on average, this software can acquire about 9 readings every 10 seconds on a Pentium® class computer. Slower computers may not be able to log data at this rate.

The readings that have been logged can be viewed by selecting the Readings History option from the View menu or by right-clicking the Channels grid and selecting the View Readings History option from the popup menu.

The logged readings can be printed by selecting the Print | Readings option from the File menu. However, only the readings that have been logged so far will be printed.

**Alarms**

The current alarm state is determined by comparing the most recent reading to the alarm settings. If the Low Alarm and/or High Alarm have been configured, the reading is compared to the low alarm and high alarm values. If the reading is less than the low alarm value and the low alarm is enabled, the Alarm box in the Channel information grid flashes Low to indicate the low alarm has “trip- ped”. If the reading is greater than the high alarm value and the high alarm is enabled, the Alarm box in the Channel information grid flashes High to indicate the high alarm has “trip- ped”. If the reading falls between the low and high alarm values or if the alarms are not enabled, the Alarms box remains blank (alarm reset).
Every time an alarm is tripped, a single entry is written to the alarm log file. This file is named “alarm.log” and is located in the default output folder or the folder that the output file is saved in.

The alarm log file can be viewed by selecting the Alarm Log from the View menu or by right-clicking on the Channels grid and selecting the View Alarm Log option from the popup menu.

**Statistics**

The Statistics section on the Real-Time Log Session window displays statistical information for the readings that have been logged. Each of the statistics can be enabled or disabled by simply checking or unchecking the appropriate check box. When a statistic is disabled, the box is left blank.

Clicking the Clear button resets all statistics, including the Count and Elapsed Time, and begins calculating the statistical data again from the next reading.

**Readings Graph**

As readings are logged, a trace is drawn on the graph to give a visual representation of the readings.

The Y-axis of the graph is always in the reading scale (units) selected on the Log Session Settings dialog. The Y-axis is automatically scaled to keep the entire visible portion of the trace within the graph bounds.

The X-axis of the graph displays elapsed time since the log session started. As the trace reaches the right side of the graph, the trace shifts to the left and the left-most part of the trace is pushed off the graph. The graph is set to display 600 readings at a time. This setting is fixed and cannot be changed. Therefore, the graph displays anywhere from 10 minutes (at a 1 second sample interval) up to 600 days (at a 24 hour sample interval) of readings.

**Note:** The elapsed time shown on the graph is only an approximate time! Anytime a menu option is selected or a dialog is displayed, data logging may be temporarily halted until the menu or dialog is closed. This causes the elapsed time to become inaccurate. The true elapsed time is displayed in the Statistics in the upper right corner of the window.

There are many customizable settings for the graph such as titles, a legend, colors, grid lines and trend lines. All of these features can be accessed by selecting the Graph Settings menu option in the Graph menu or by right-clicking on the graph and selecting the Graph Settings option from the popup menu. The default graph settings can be restored by selecting the Restore Default Settings option from the Graph menu.
The trace color for the readings can be changed by selecting the Trace Color option from the Graph menu or by right-clicking on the Channels grid or graph and selecting the Trace Color option from the popup menu. 

**Note:** If the trace does not appear on the graph, make sure the trace and background colors of the graph are not set to the same color.

The graph may be printed at any time by selecting the Print | Graph option from the File menu or by selecting the Print Graph option in the Graph menu.
5 Download Menu

The Download menu (Figure 24) provides options for downloading logged readings from a thermometer and checking the log status.

![Download Menu](image)

*Figure 24  Download Menu*

5.1 Download Logged Data

The Download Logged Data menu option allows readings that are stored in the memory of the thermometer to be downloaded and written to a file. When this menu option is selected, the Select Model dialog is displayed (see Section 8.5). Select the thermometer model and communication settings to use and click the OK button.

**Note:** Currently, only the Model 1522 LLL Handheld Datalogger supports this feature.
After the thermometer is selected, the 1522 Download dialog (Figure 25) is displayed.

![1522 Download Dialog](image)

Figure 25  1522 Download Dialog

The 1522 Download dialog allows the user to select the settings for downloading Autolog or Demand log data.

**Select Log**

Select the type of logged data to download. Refer to the thermometer’s User Guide for an explanation on the differences between the autolog and demand log data.

**Download Options**

Select the download mode to use when downloading the data. When using the I/R dongle, the data can be downloaded in either binary mode or ASCII mode. When using the RS-232 serial cable, the Binary mode option is disabled.

Obviously, it would be preferable to download the logged data as fast as possible. However, the user must be aware that there are some trade-offs when using the Binary mode instead of ASCII mode to download the data. Please read the following to understand these trade-offs:
<table>
<thead>
<tr>
<th></th>
<th>ASCII Downloading</th>
<th>Binary Downloading</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Speed</strong></td>
<td>Disadvantage: Downloading data in ASCII mode is inherently much slower than Binary mode because more information (bytes) must be sent for each reading. Typically, ASCII mode requires that 40 bytes be sent (which includes the date, time, value, scale and label) for each reading. Therefore, to download 10,000 readings in ASCII mode requires the thermometer to send 400,000 bytes (approximately 390KB) of information to the software.</td>
<td>Advantage: Downloading data in Binary mode is much faster than ASCII mode because the information can be compacted into fewer bytes for each reading. Typically, Binary mode requires that only 10 bytes be sent (which also includes the date, time, value, scale and label) for each reading, plus a few bytes for overhead information. Therefore, to download 10,000 readings in Binary mode requires the thermometer to send approximately 100,000 bytes (approximately 98KB) of information to the software, which is only 25% as much information than in ASCII mode making the significantly faster! (see table below)</td>
</tr>
<tr>
<td><strong>Transmission Error Detection</strong></td>
<td>Disadvantage: In ASCII mode, the software has difficulty knowing whether or not all readings have been received. The software attempts to determine if any readings are missing by comparing the total readings received to the number of readings the thermometer says were sent. If there is a difference, an error message is displayed alerting the user to download the data again. This technique does not catch all types of errors, however.</td>
<td>Advantage: In Binary mode, the 1522 first sends out a header packet which is basically some information about how many readings are to be sent. Then the readings themselves are sent. Following the readings, another packet of information is sent which contains a checksum. This checksum is compared to a checksum which is calculated by the software to determine if all readings were received properly, without error. If an error is detected, an error message is displayed alerting the user to download the data again. This is a very good error checking technique which eliminates nearly all transmission related errors.</td>
</tr>
</tbody>
</table>
### Rounding and Truncation Errors

**Advantage:** In ASCII mode, the thermometer sends the actual digits of each reading including the date, time, value, scale and label number. No translation is required. The readings are simply written to the download file as received.

**Disadvantage:** In Binary mode, the thermometer sends a binary representation of each reading including the date, time, value, scale and label number to the software. The software must then translate each reading into the actual date, time, value, scale and label number before writing it to the download file. This technique tends to introduce minor errors because of rounding and truncation errors in floating point numbers. Typically, these errors are on the order of 1mK which is well out of the specification of the 1522 LLL Handheld Datalogger. These errors do not occur on the date, time, scale and label number, only the value of the reading. For complete information on the extent of the error introduced by these discrepancies, please see Section 5.4 Binary Download Discrepancies.

The following table gives some approximate download times for ASCII and binary modes using the serial and I/R ports:

<table>
<thead>
<tr>
<th>Download Mode and Interface</th>
<th>Approx. Download Time for 10,000 Readings</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/R – Binary mode</td>
<td>90 seconds</td>
</tr>
<tr>
<td>I/R – ASCII mode</td>
<td>22 minutes</td>
</tr>
<tr>
<td>RS-232 – Binary mode</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>RS-232 – ASCII mode</td>
<td>22 minutes</td>
</tr>
</tbody>
</table>

### File Options

The File Options allow the user to determine how to write the downloaded data to download files.

- **Write all readings to a single file** – All downloaded readings can be written to the same file by selecting this option. Selecting this option creates one download file with the name OUTPUT.TXT and saves the file in the folder specified below. All downloaded readings, regardless of the assigned label, are written to this one file. *It is highly recommended that this option be selected when downloading Demand Log data.*

- **Write readings to separate files** – Downloaded readings can be written to multiple files by selecting this option. As readings are downloaded, one file is created for each unique label that has been assigned to a reading.
All readings that were assigned a given label are written to the same file regardless of whether the readings are contiguous (all together) or spread throughout the log. The filenames of the download files in this case consist of the label followed by a .TXT extension. All files are saved in the folder specified below.

**Note:** Be careful using this option if no label was assigned to some or all readings. If no label is assigned to a reading, the reading is given a numerical label indicating the reading number. When writing readings to separate files based on the label, one file will be created for each reading! If 100 readings were downloaded, the software may attempt to create 100 separate files with one reading in each file!

The other file options allow the user to decide how to handle overwriting existing files in the selected folder.

**Prompt to enter all filenames** – Checking this option causes the Windows® Save As dialog to appear before each download file is created to allow the user to either change the filename or folder to which the file will be written. When writing readings to separate files, checking this option could become very time-consuming if many files need to be created. If this option is checked, the Prompt before overwriting existing files option is disabled.

**Prompt before overwriting existing files** – This option is only enabled if the Prompt to enter all filenames option is not selected. Checking this option causes the Windows® Save As dialog to appear ONLY when the software attempts to create a download file that has the same name as an existing file in the selected folder. The user can either select a different folder or change the name of the file to avoid overwriting the existing file. Leaving this option unchecked will automatically overwrite any existing files that have the same name as the download files. *It is recommended that this option always be checked.*

The Write files to box allows the user to select or enter the folder to which the download files should be written. This folder defaults to the download folder that is selected on the File | Defaults Folders tab. If the folder to which the download files should be written already exists, use the ‘...’ (Browse) button to select the folder. If the folder does not exist, enter the folder name directly into the box provided. This folder will be created automatically.

Click the Download button to begin the download process.

Click the Close button to close the Download dialog after downloading is complete.

Click the Help button to display the appropriate help topic for this dialog.
5.2 Log Status

The Log Status menu option displays the status of the thermometer log(s). When this menu option is selected, the Select Model dialog is displayed (see Section 8.5). Select the thermometer model and communication settings to use and click the OK button.

**Note:** Currently, only the Model 1522 LLL Handheld Datalogger supports this feature.

After the thermometer is selected, the 1522 Log Status dialog (Figure 26) is displayed.

![1522 Log Status Dialog](image)

**Figure 26** 1522 Log Status Dialog

The 1522 Log Status dialog displays information about the logs in the 1522 LLL Handheld Datalogger. The 1522 LLL Handheld Datalogger contains two logs: Demand log and Autolog. For more information on these logs, refer to the 1522 LLL Handheld Datalogger User Guide.

**Demand Log Status**

The Demand Log Status section indicates the current status of the demand log. The demand log is capable of storing up to 100 readings which consist of the value, units, date, time, and a label. The progress bar indicates how many readings are already stored in the demand log.

These readings can be downloaded by selecting the Download Logged Data option from the Download menu (see Section 5.1).
The labels that can be assigned to each reading in the demand log can be viewed and changed by selecting the Write Labels option from the Tools menu.

To clear the demand log, click the Clear Log button. All readings stored in the demand log will be lost.

**Autolog Status**

The Autolog Status section indicates the current status of the autolog. The autolog is capable of storing up to 10,000 readings which consist of the value, units, date, time, and a label. The progress bar indicates how many readings are already stored in the autolog.

These readings can be downloaded by selecting the Download Logged Data option from the Download menu.

The labels that can be assigned to each reading in the autolog can be viewed and changed by selecting the Write Labels option from the Tools menu.

To clear the autolog, click the Clear Log button. All readings stored in the autolog will be lost.

**Refresh**

Click the Refresh button to update the log status indicators.

Click the Close button to close this dialog.

Click the Help button to display the help topic for this dialog.

### 5.3 Download Process

The download process consists of the following steps:

- **Check communication** – Before any downloading begins, the software checks to make sure it can communicate with the thermometer. If communication succeeds, the download process continues. Otherwise, an error message is displayed and the download process is aborted.

- **Read data labels** – The current data labels are read in from the thermometer. When downloading readings, the data label number is downloaded as opposed to the label itself to improve the total download time. As readings are parsed, the label number is replace with the appropriate label.

- **Download readings** – Next, the software begins to download the actual readings including the date, time, value, scale and label index. Depending on how many readings are being downloaded and the selected download options, this process could take anywhere from 2
seconds to over 20 minutes. **Note:** For binary downloads, please read Section 5.4 Binary Download Discrepancies.

- **Parse readings** – After all readings have been downloaded, the software parses the data. This process includes translating binary data into ASCII text (if the readings were downloaded in Binary mode) and breaking up the date, time, value, scale and label into separate entities in preparation to write the readings to the download file(s). This process also includes replacing the label number associated with each reading with the actual label text.

- **Write readings to file(s)** – The last step of this process is writing the readings to the download file(s) based on the selected file options.

If an error was detected during the download process, an error message will be displayed and the download process will be aborted. The user may also abort the download process by clicking the Cancel button on the progress indicator that is displayed during the various operations.

**Note:** Anytime the download process is aborted, it is recommended that the thermometer be powered off then back on again. This is the only way to force the thermometer to abort the download process.

If the download process completes successfully, the Downloaded Files dialog (Figure 27) is displayed.

![Downloaded Files Dialog](image)

This dialog shows a list of all files that were created by the download process including the location of each file. Any of the files listed can be opened in the Windows® default text editor by double-clicking on the appropriate entry in the list.

Click the OK button to close this dialog.
5.4 Binary Download Discrepancies

The Model 1522 LLL Handheld Datalogger has built-in RS-232 and I/R ports. LogWare supports both interfaces for downloading logged readings from the memory of the 1522. Using the RS-232 serial interface, the readings can only be downloaded in ASCII mode (all readings are downloaded as text). However, when using the I/R interface, the readings can be downloaded in either ASCII mode (text) or in binary mode. Binary mode has many advantages over ASCII mode, but also has some disadvantages.

**Binary Mode Advantages**

The major advantage of using binary mode to download readings is speed, which translates into time. The 1522 is capable of logging up to 10,000 readings in its autolog. Downloading these readings (which consist of the date, time, value, units and label index) in ASCII mode can take up to 20 minutes or more at the fixed baud rate of 2400 baud. Binary mode both reduces the number of bytes that need to be sent per reading and uses a higher baud rate (115,200 baud) to significantly reduce the download time. See the table below for details:

<table>
<thead>
<tr>
<th>Download Mode and Interface</th>
<th>Approx. Download Time for 10,000 Readings</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/R – Binary mode</td>
<td>90 seconds</td>
</tr>
<tr>
<td>I/R – ASCII mode</td>
<td>22 minutes</td>
</tr>
<tr>
<td>RS-232 – Binary mode</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>RS-232 – ASCII mode</td>
<td>22 minutes</td>
</tr>
</tbody>
</table>

Also, binary mode adds some error detection to ensure that readings are properly transmitted.

**Binary Mode Disadvantages**

The major disadvantage of using binary mode is that it introduces small discrepancies into the readings due to rounding and truncation errors. The readings that are transmitted to the PC in binary format are “encoded” and must be “decoded” once they are received. This decoding sometimes introduces small errors into the readings. Typically, these errors are on the order of 1mK which is well within the specification of the 1522 LLL Handheld Datalogger. These errors do not occur on the date, time, units or label index, only the value of the reading. The following table indicates maximum observed errors at various resistances and conversion settings:
<table>
<thead>
<tr>
<th>Reference Resistor (Ohms)</th>
<th>1522 Conversion Setting</th>
<th>Maximum Observed Error (Kelvin)</th>
<th>1522 Uncertainty Specification (Kelvin)</th>
<th>Error Percentage of Uncertainty (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>23.2</td>
<td>PRT</td>
<td>±0.0001</td>
<td>±0.025</td>
<td>0.4</td>
</tr>
<tr>
<td>100</td>
<td>PRT</td>
<td>±0.00005</td>
<td>±0.025</td>
<td>0.2</td>
</tr>
<tr>
<td>249</td>
<td>PRT</td>
<td>±0.001</td>
<td>±0.05</td>
<td>2.0</td>
</tr>
<tr>
<td>1.0K</td>
<td>Thermistor</td>
<td>±0.00005</td>
<td>±0.01</td>
<td>0.5</td>
</tr>
<tr>
<td>10.0K</td>
<td>Thermistor</td>
<td>±0.00005</td>
<td>±0.005</td>
<td>1.0</td>
</tr>
</tbody>
</table>

Because the maximum observed error is at most 2.0% of the uncertainty of the instrument, the error introduced by rounding and truncation is considered insignificant.
6 View Menu

The View menu (Figure 28) provides options for customizing LogWare's main window, viewing information about a real-time log session and opening previously logged data files.

![View Menu](image)

Figure 28 View Menu

The toolbar and status bar can be displayed by checking the Toolbar and Status Bar menu options respectively. To hide the toolbar or status bar, uncheck the appropriate menu option.

During a real-time log session, the Alarm Log and Readings History options are enabled. Selecting the Alarm Log menu option displays the alarm log file for the current real-time log session. Selecting the Readings History menu option displays all of the readings in the output file for the current real-time log session.

Selecting the Open Previously Logged Data File menu option displays the Windows® Open dialog and allows output files or download files to be opened. When the file is opened, the readings, statistics and graph of the readings are displayed in a Log File window.

The filename list at the bottom of the View menu lists up to 8 of the most recently opened files. To open one of these files, simply click on the appropriate filename in the list. The file is opened and displayed in a Log File window.
6.1 Alarm Log

The Alarms.log dialog (Figure 29) displays the alarms that have occurred since the data acquisition session started.

Grid

The alarm log grid displays the date, time, label, alarm type, and the value of the reading for every time an alarm tripped (reading exceeded alarm setting) or reset (reading returned to within alarm setting).

Refresh

This dialog only displays the entries that have been written to the alarm log file at the time the window was displayed. If more entries have been written to the alarm log file, click the Refresh button to read in the alarm log file again.

Print

To print the alarm log file to the default printer, click the Print button. To select the default printer, select the Print Setup menu option from the File menu.

Alarms

To view the current alarm settings, click the Alarms button to display the Alarms dialog.
Click the Close button to close this dialog.

6.1.1 **Alarms**

The Alarms dialog (Figure 30) shows the current settings for the low and high alarms. The alarms must be set before starting a real-time log session by clicking the Alarm Settings button on the Log Session Settings dialog. Once a real-time log session starts, the alarm settings cannot be changed.

![Alarms Dialog](image)

**Figure 30**  Alarms Dialog

**Low Alarm**

The Low Alarm box is read-only and indicates the current low alarm setting.

**High Alarm**

The High Alarm box is read-only and indicates the current high alarm setting.

Click the Close button to close this dialog.
6.2 Readings History

Use the Readings History menu option to view the data that has been logged during the current real-time log session (Figure 31).

Grid

The grid displays all of the readings from the output file for the selected channel. When this dialog is displayed, the grid is positioned at the very bottom to display the most recent readings. Use the scroll bar to scroll through the readings.

Refresh

The real-time log session continues even when this dialog is displayed. This dialog only shows the entries that have been written to the output file at the time the dialog was displayed. If more entries have been written to the output file, click the Refresh button to read in the output file again. Statistical data is recalculated to include any new readings.

Print

To print the output file to the default printer, click the Print button. To select the default printer, select the Print Setup menu option from the File menu.
Statistics
When the output file is read in, statistical information is calculated. Click the Statistics button to view the Statistics dialog.

Click the Close button to close this dialog.

6.2.1 Statistics
The Statistics dialog (Figure 32) displays the statistics for the readings in the output file for the selected channel at the time the output file was read in.

![Statistics Dialog](image)

*Figure 32  Statistics Dialog*

Click the Close button to close this dialog.

6.3 Open Previously Logged Datafile
Selecting the Open Previously Logged Data File menu option displays the Windows® Open dialog box. Select the output file or download file to open. Then click the Open button to open the file. The Log File window (Figure 33) is displayed with the readings, statistical information and a graph.

**Note:** The graph is only capable of displaying up to 32,767 readings at a time. If the selected file contains more readings, a message is displayed alerting the user and only the first 32,767 readings are read in.

**Note:** The Open Previously Logged Data File menu option is intended to open ONLY output files and download files that were created by this software (see Section 11)! Attempting to open a file that was not created by this software will most likely fail and may cause unpredictable results.
Up to 8 previously logged data files can be opened at once. Each file is opened in its own window. Use the Window menu to see a list of the open windows or to arrange the windows.

![Log File Dialog](image)

**Figure 33  Log File Dialog**

### Readings

The Readings section displays each reading including the date and time, reading value and alarm information in a grid. Use the scroll bar to scroll through all of the readings.

**Note:** If a download file was opened, the alarms column does not appear in the readings grid.

### Statistics

The Statistics section displays statistics for all of the readings in the file that was opened. The Elapsed Time box displays the time difference between the first reading and the last reading in the file.
Readings Graph

After the selected file has been read in, a trace is drawn on the graph to give a visual representation of the readings.

The Y-axis of the graph is always in the reading scale (units) in which the readings were written to the file. The Y-axis is automatically scaled to keep the entire trace within the graph bounds.

The X-axis of the graph displays an approximate time scale. As the readings are read from the file, the software calculates the time interval between each reading. After the entire file has been read in, the software uses the average interval between all readings as the interval between each point. For this reason, if all of the readings in the file are not separated by the same time interval, the graph will not be 100% accurate.

Note: The readings graph is only capable of displaying up to 32,767 readings at a time. If the selected file contains more readings, a message is displayed alerting the user and only the first 32,767 readings are read in.

There are many customizable settings for the graph such as titles, a legend, colors, grid lines and trend lines. All of these features can be accessed by selecting the Graph Settings menu option in the Graph menu or by right-clicking on the graph and selecting the Graph Settings option from the popup menu. The default graph settings can be restored by selecting the Restore Default Settings option from the Graph menu.

The trace color for the readings can be changed by selecting the Trace Color option from the Graph menu or by right-clicking on the graph and selecting the Trace Color option from the popup menu.

The graph may be printed at any time by selecting the Print | Graph option from the File menu or by selecting the Print Graph option in the Graph menu.

To zoom in to view a section of the graph more closely, select the Zoom In option from the Graph menu or select the Zoom In toolbar button. To restore the graph to its normal, unzoomed state, select either the Restore option or the Zoom In option from the Graph menu, or click either the Restore toolbar button or the Zoom In toolbar button to exit “zoom mode”.

To close a log file window, activate the window to close by clicking on it with the mouse, then click the X box in the upper right corner of the log file window.
7 Graph Menu

The Graph menu (Figure 34) provides options for configuring the graph settings, restoring the default graph settings, changing the trace color, zooming, and printing the graph.

![Graph Menu](image)

*Figure 34  Graph Menu*
7.1 Graph Settings

The Graph Settings dialog (Figure 35) allows the user to change the way the graph is displayed.

**Figure 35  Graph Settings Dialog**

The following features can be changed:

- **Titles** – Enter or change the graph, bottom, left, right titles. Set the orientation of the left and right titles horizontally, up or down

- **Axis** – Change the axis color, position, scale and range. Select whether or not to show the tick marks and a grid

- **Fonts** – Change the typeface and size of the graph titles, labels and legend

- **Trends** – Select to display statistical lines (mean, min/max, standard deviation, best fit, curve fit) and limit (alarm) lines
Background – Select the style and background color for the titles, legend, and graph

Legend – Enter the legend text, the size and position of the legend

System – Print the graph, export the graph to a graphics file or save the current graph settings to a template file

Click the OK button to save the settings you have selected and to close the Graph Settings dialog.

Click the Cancel button to discard any changes and close the Graph Settings dialog.

Click the Apply Now button to apply the settings you have selected to the graph without closing the Graph Settings dialog. This button is useful when you want to try different features for the Graph Settings dialog.

Click the Help button to display the appropriate help topic for this dialog.

7.1.1 Titles

The Titles tab (Figure 36) allows the user to enter the titles to appear on the top, bottom, left and right sides of the graph.

![Figure 36 Graph Settings - Titles Tab](image)
When you enter text for a title, the Graph control adjusts the rest of the graphing window to provide space—either redrawing the graph and associated objects at a smaller size or decreasing the space between objects. When you clear the text box for a title, you disable it and provide more space for the rest of the graph.

If you enter a title that’s too long to appear in a single line, the Graph control automatically word-wraps it. If a title doesn’t display at all, it’s because the Graph control can’t make the font small enough to fit all the text in the space provided. Increase the size of the graphing window to make the title appear.

**Note:** To restore the titles to their default settings, select the Restore Default Settings option from the Graph menu.

**Graph Title**
Enter the top title for the graph. The graph title can contain up to 80 characters. This title appears centered at the top of the graph. By default, the graph title is blank.

**Bottom Title**
Enter the bottom title for the graph. The bottom title can contain up to 80 characters. This title appears centered at the bottom of the graph and is generally used to denote the scale of the X-axis. By default, this title is set to “Time”.

**Left Title**
Enter the left title for the graph. The left title can contain up to 80 characters. This title appears centered vertically on the left side of the graph and is generally used to denote the scale of the Y-axis. The title can be displayed horizontally or vertically running up or down. By default, this title is set to the Readings Scale with the Up orientation option selected.

**Right Title**
Enter the right title for the graph. The right title can contain up to 80 characters. This title appears centered vertically on the right side of the graph and is generally used to denote the scale of a secondary Y-axis. The title can be displayed horizontally or vertically running up or down. By default, the right title is blank.
7.1.2 Axis

The Axis tab (Figure 37) can be used to customize the graph’s X- and Y-axis settings, colors, ticks and gridlines.

![Axis Tab](Image)

**Figure 37** Graph Settings - Axis Tab

**Note:** To restore the axes to their default settings, select the Restore Default Settings option from the Graph menu.

**Apply to Axis**

Select the axis for which changes are to be made. The other controls on this tab change to reflect the current settings of the selected axis. By default, the Y Overlay and Z axes options do not apply to the graph and are not enabled.

**Color of Axes**

Select the color for the X-and Y-axes by selecting a color bar from the drop-down list. This setting applies to both axes and is therefore independent of the current Apply to Axis setting. By default, this option is set to black.
Position

The Position options allow the X-axis to be positioned on either the top or bottom of the graph and the Y-axis to be positioned on either the left or right side of the graph. Selecting the Variable option allows the graph itself to determine whether to position the axes on the top, bottom, left or right side.

By default, the X-axis is set to Bottom and the Y-axis is set to Left.

Scale

The Scale options allow the user to determine the minimum and maximum values for an axis. Each option is described below:

Zero Origin – This option draws the selected axis including the origin (zero) and extending far enough in the positive and negative directions to include all of the graph’s values

Variable Origin – Select this option to have the axis “zoom in” on the range of the graph’s actual values, whether or not that range includes zero.

User-Defined – This option allows the user to set values for the minimum, maximum, and number of ticks for the axis. When this option is selected, the settings in the Range group are enabled

By default, the X-axis and Y-axis are both set to Variable Origin.

Note: Changing the Scale settings (especially for the X-axis) while acquiring real-time data could possibly cause graphing problems to occur. Therefore, it is recommended that these settings NOT be changed by the user when acquiring real-time data.

Range

The Range options are only enabled if the User-Defined option is selected in the Scale options for the selected axis. Enter the Maximum and Minimum values for the selected axis. The selected axis is rescaled to the settings entered.

The Ticks option allows the user to determine how many major tick marks should be displayed between the minimum and maximum values on the selected axis. Each major tick mark is labeled with the appropriate value. The tick marks themselves are only displayed if the Show check box in the Tick Marks controls is checked.

By default, these settings are not used by the software because of the default Scale settings.
**Tick Marks**

The Tick Marks options allow the user to specify whether or not to show tick marks on the selected axis. To show tick marks, check the Show check box. If this check box is not checked, the tick marks are not shown on the selected axis. Valid settings are between 1 and 1000.

The Every option is only enabled for the X-axis. This option determines how often major tick marks appear on the X-axis. When acquiring real-time data, the graph displays the most recent 600 readings acquired. The Every option is set to 150 meaning that a major tick mark appears every 150 readings, or 600 divided by 150 = 4 major tick marks appear on the X-axis. When analyzing previously acquired data, the Every option is calculated by the software depending on the number of readings being displayed. The X-axis must end with a tick mark. If you set an Every value that doesn’t include the last value on the axis, the graph will extend the X-axis so that it ends on a tick mark.

The Minor option allows the user to determine how many minor tick marks appear between each major tick mark. By default, the X-axis and Y-axis are set to display 5 minor tick marks between major tick marks. Valid settings are between 0 and 100.

The Through Axes, Inside Axes and Outside Axes options allow the user to specify how the tick marks should be drawn on the axis. By default, both the X-axis and Y-axis are set to Through Axes.

**Grids**

The Grids options allow the user to specify whether or not to display grid lines on the graph. To show the grid lines for the selected axis, check the Show check box. Select the list Style and Color for the grid lines. Both axes are set to the same style and color, but each axis can be set to show or hide grid lines independent of the other.

By default, grid lines are not shown on the graph.
7.1.3 Fonts

The Fonts tab (Figure 38) can be used to change the typefaces and sizes of fonts used on the graph.

![Figure 38 Graph Settings - Fonts Tab](image)

**Note:** To restore the fonts to their default settings, select the Restore Default Settings option from the Graph menu.

**Apply To**

Select the title, label or legend option to which the font settings are to be applied. The Typeface and Size controls display the current settings for the selected option.

**Typeface**

Select the font name from the drop-down list and choose the styles to apply to the selected title, label or legend.

**Size**

Select the font size to apply to the selected title, label or legend by clicking on the scroll bar or dragging the scroll bar’s thumb. Selecting the
Smart Scale option allows the graph to automatically reduce the size of the selected font if the dimensions of the graph become too small to display the title, label or legend in the selected font size. Click the Reset button to restore the size to its default setting.

7.1.4 **Trends**

The Trends tab (Figure 39) can be used to superimpose trend lines (Min, Max, Average, etc.), curve fit and limit (alarm) lines on the graph.

![Figure 39](image)

**Figure 39** Graph Settings - Trends Tab

**Note:** To restore the trend settings to their default settings, select the Restore Default Settings option from the Graph menu.

**Statistical Lines**

These options allow the user to specify which statistical lines should be displayed on the graph.

Check the All Sets option to apply the statistical lines settings to all of the sets (traces) on the graph. When this check box is checked, the Set Number controls are disabled.
The Set Number box allows the user to select which set (trace) to which to apply the statistical lines settings. This setting can only be changed if the All Sets check box is not checked.

**Note:** This software only has one set of data. When acquiring real-time data, this set is the data being acquired. When analyzing previously acquired data, this set is the data which was previously acquired.

Check the Mean check box to enable a mean line, which is drawn horizontally through the average value of all data points in the selected set.

Check the Min/Max check box to enable min and max lines, which are drawn horizontally through the lowest and highest data points in the selected set.

Check the Std Dev check box to enable a pair of standard-deviation lines, which are drawn horizontally through the standard deviation from the mean (in both the positive and negative directions) for the selected set.

Check the Best Fit check box to enable a best-fit line, which is a straight line indicating the trend of data points (a first-order polynomial curve) for the selected set.

Check the Curve Fit check box if you want to fit a curve through your data points for the selected set. You can choose the type, order and granularity of the curve in the Curve Fit options below. These settings will apply to all curve fit lines drawn on the graph.

By default, no trend lines are enabled.

**Curve Fit**

Select the curve fit options for the curve fit statistical line. The following options are available:

<table>
<thead>
<tr>
<th>Curve Type Variable-Order Polynomial</th>
<th>Description/Formula Polynomial Curve of Variable Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logarithmic</td>
<td>$y = a + b \cdot \log(x)$</td>
</tr>
<tr>
<td>Exponential 1</td>
<td>$y = a \cdot \exp(b \cdot x)$</td>
</tr>
<tr>
<td>Exponential 2</td>
<td>$y = a \cdot x \cdot \exp(-b \cdot x)$</td>
</tr>
<tr>
<td>Power</td>
<td>$y = a \cdot (x^b)$</td>
</tr>
<tr>
<td>Inverse 1</td>
<td>$y = a + b / x$</td>
</tr>
<tr>
<td>Inverse 2</td>
<td>$y = a / (b + x)$</td>
</tr>
<tr>
<td>Inverse 3</td>
<td>$y = 1 / (a + b \cdot x)$</td>
</tr>
<tr>
<td>Inverse 4</td>
<td>$y = x / (a \cdot x + b)$</td>
</tr>
<tr>
<td>Inverse 5</td>
<td>$y = 1 / (a + b \cdot x)^2$</td>
</tr>
<tr>
<td>Curve Type</td>
<td>Description/Formula</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Variable-Order Polynomial</td>
<td>Polynomial Curve of Variable Order</td>
</tr>
<tr>
<td>Spline</td>
<td>Spline fit through all points</td>
</tr>
<tr>
<td>Moving Average Mid</td>
<td>Moving average plotted at midpoint of averaged group</td>
</tr>
<tr>
<td>Moving Average End</td>
<td>Moving average plotted at end point of averaged group</td>
</tr>
</tbody>
</table>

The Order option applies only to three curve types:

For **variable-order polynomial** curves, Order is the order of the polynomial used in curve fitting. A setting of 1 produces a straight line (the same as a best-fit line); a setting one less than the number of points produces a curve that passes through every point.

For **moving-average mid** and **moving-average end** curves, Order is the range of data points over which moving averages are averaged, beginning with the first point.

The Granularity scroll bar sets the granularity of all curve types except moving-average. The granularity is the number of “steps,” or straight line segments, making up the curve. Higher values create smoother curves, but require more drawing time. The default Granularity setting is 50 curve steps, which generally creates a smooth-looking curve at a high drawing speed. Each click to the left decreases the number of steps by 2 (to a minimum of 10), and each click to the right increases the number of steps by 2 (to a maximum of 1000). With spline curves, you generally need higher granularities than normal—up to 10 times the number of points in the graph.

**Color**

Select the colors for each of the statistical lines to display on the graph. The selected color for each statistical line applies to that statistical line for all sets of data.

**Limit Lines**

Select the limit (alarm) lines options to display on the graph. To display the high alarm line, check the High check box. To display the low alarm line, check the Low check box.

By default, the low and high limit values are set to the low and high alarm values entered on the Alarm Settings dialog. The limit lines, however, are not displayed by default.
Note: Changing the low and high limit line settings on this dialog **DOES NOT** change the low and high alarm settings entered on the Alarm Settings dialog and therefore does not affect the alarm events options. These settings are only used to display the alarm lines on the graph. Only change these settings if absolutely necessary.

Select the line style for the limit (alarm) lines using the Line drop-down list. A fill pattern can also be selected using the Fill drop-down list. Select the color of the limit (alarm) lines and the fill pattern using the Color drop-down list.

Select the Fill Opposite check box to fill the area between the High and Low limit (alarm) lines with the selected pattern. If this option is not checked, the areas above the High limit value and below the Low limit value are filled in with the selected pattern.

Enter the text to appear as a label on the High and Low limit (alarm) lines in the High Label and Low Label boxes. By default, these labels are set to “High Alarm” and “Low Alarm” respectively.

**Note:** Unlike statistical lines, the graph can only display one set of limit (alarm) lines for all sets of data (traces).
7.1.5 **Background**

The Background tab (Figure 40) can be used to set the background colors of titles, the legend and the graph itself.

*Figure 40  Graph Settings - Background Tab*

**Note:** To restore the background settings to their default settings, select the Restore Default Settings option from the Graph menu.

**Apply To**

Select the title, legend or graph option to which the background settings are to be applied. The other controls on this tab change to show the current settings for the selected item.

**Style**

Select the background style options to apply to the selected title, legend or graph. Select the text and background color for the selected item using the drop-down lists provided.
**Graph Window**

Select the background options for the graph window. Use the Background Color drop-down list to select the background color for the plotting area of the graph.

The Backdrop option can be used to display a graphic (.BMP or .WMF) file such as a company logo or texture pattern behind the graph. If any other option except “None” is selected, the File and Browse button controls are enabled. Enter the name of the file or browse for the filename using the Browse button.

**Palette**

Select the color palette to use. Using this drop-down list, choose a 16-color or 128-color palette for the screen. All of the Color drop-down lists for the graph settings use this palette to determine the available choices.

**16-color palettes** consist of 16 differentiated colors—default, pastel, or grayscale

**128-color palettes** always consist of the 16 colors from the default palette, followed by 96 colors that vary according to the palette you select. The graph reserves 16 additional colors for special graphic needs. These colors cannot be selected

By default, the “16 Default” palette is selected.

**Note:** Selecting any other palette will invalidate the Trace Color option on the Log Session Settings dialog. The Palette option should NOT be changed.
7.1.6 Legend

The Legend tab (Figure 41) can be used to add a legend to the graph.

![Legend Tab](image)

*Figure 41*  Graph Settings - Legend Tab

**Note:** To restore the legend settings to their default settings, select the Restore Default Settings option from the Graph menu.

**Legend Text**

Click the Text button to enter the labels for each set (trace) of data on the graph. By entering text into the boxes provided, the legend will automatically appear on the graph. To hide the legend, remove the text from all of the boxes.

By default, all of the legend text boxes are empty causing the legend to be hidden.

**Position**

Select the position with respect to the graph to place the legend.
Size
Select the size of the legend. To change the font or style that the legend uses, see the Fonts tab. To set the legend colors, see the Background tab.

7.1.7 System
The System tab (Figure 42) can be used to print and export the graph and to save the current graph settings to a template file.

![Graph Settings - System Tab]

Figure 42 Graph Settings - System Tab

Printing
The graph can be printed to the currently selected printer by selecting the Print button.

The graph can be printed with or without a border by selecting the Border check box.

The Mono and Color options determine how the trace is printed. If the Mono option is selected, every point on the trace has a predetermined marker. This is to be able to distinguish one trace from another when printing graphs on monochrome (black & white) printers. Selecting the
Color option removes the markers from the trace, producing a more readable graph, but makes it more difficult to distinguish between two traces.

To print the graph in a landscape orientation, select the Landscape check box. If this check box is not selected, the graph will be printed in the portrait orientation.

| Portrait | Landscape |

To force the graph to fill an entire page, select the Full page check box. If this check box is not checked, the graph will be printed as close to its actual size as possible.

The graph can also be printed by selecting the Print | Graph option from the File menu or by selecting the Print Graph option from the Graph menu. The default printer can be set by selecting the Print Setup option from the File menu.

**Export Image**

The graph can be exported to a graphics file or the clipboard. Select the type of file to export it to in the Format group:

- Select the WMF option if you want to create a metafile of the graph.
- Select the BMP option if you want to create a bitmap of the graph.
- Select the JPEG option if you want to save an image of the graph in JPEG format.
- Select the PNG option if you want to save an image of the graph in PNG format.

To export the graph to a file, select the File option in the Target group and enter the filename or click the browse button to select the filename and location. Click the Copy button to save the graph image to the selected file.

To copy the graph to the clipboard, select the Clipboard option in the Target group and click the Copy button. A copy of the graph is sent to the clipboard and can now be pasted into other applications.

**Export Map File**

An image of the graph can also be exported to a map file.

Select a format for an image map using the Format drop-down list. Then, set the name attribute for a client-side image map by entering the name
in the Tag box. Click the Ref. Strings button to enter an array of URLs for use in the image map. Enter the filename for the image map file by entering it into the File box or click the Browse button to select the filename and location. For a client-side image map, this file should be the filename and extension of the HTML document. For a server-side image map, use the same base filename for both the image and the map. Often the map file’s extension is .MAP, though other extensions are usually acceptable.

**Graph Template**

The current graph settings can also be saved to a template file. If the user has customized the graph and the custom settings need to be used over and over again, the custom settings can be saved to a template file. The template file can then be loaded to restore the custom settings.

To save the data along with the graph settings, check the Save Data check box. If this check box is not checked, the data will not be saved in the template file.

To save the current graph settings to a template file, enter the filename in the File box or use the browse button to select the filename. The default extension for template files is .GSP. Multiple templates can be saved to the same template file. Assign this template a name by entering the name in the Name box provided. Click the Save button to save the graph settings to the template file.

To load a saved template, enter the filename in the File box or use the browse button to select the filename. Use the Name drop-down list to select the name of the template to load and click the Load button.

**Note:** Although this feature works for the most part, some inconsistencies have been observed. If a template file is loaded when viewing previously logged data, the data gets corrupted and is lost. If a template file is loaded when logging real-time data, the graph will display corrupted data (although any data that has already been logged is saved to an output file and **does not** get corrupted) until the graph scrolls completely to the left.

**7.2 Restore Default Settings**

The Restore Default Settings menu option can be used to quickly restore the graph to its default settings and undoing any user customization.

To customize a graph’s settings, select the Graph Settings option from the Graph menu.
7.3 **Trace Color**

The Trace Color dialog (Figure 44) allows a new color to be selected for the graph trace. The current trace color is selected when the dialog is displayed. Select the new color using the Trace Color drop-down list.

![Trace Color Dialog](image)

*Figure 44 Trace Color Dialog*

Click the OK button to save the settings you have selected and to close the dialog.

Click the Cancel button to discard any changes and close the dialog.

Click the Help button to display the appropriate help topic for this dialog.

7.4 **Zoom In**

The Zoom In menu option or toolbar button allows the user to magnify and view a small portion of the entire graph (Figure 43). This feature is not available when logging real-time data. The menu option and toolbar button are only enabled when viewing previously logged data.

![Zoom In](image)

*Figure 43 Zoom In*
To zoom in to a portion of the graph, select the Zoom In option from the Graph menu or click the Zoom In toolbar button. The toolbar button remains depressed and a check mark appears next to the Zoom In menu option indicating that the mouse is now in “zoom mode”. When the mouse pointer is placed over the graph, the cross-hair cursor appears instead of the default arrow cursor.

Use the mouse to select the portion of the graph to zoom in to by clicking the left mouse button and holding it down while dragging the mouse to draw a rectangular box around the desired area. Releasing the mouse button causes the graph to zoom in to the selected area. The Readings grid is also repositioned to show the left-most point on the graph in the top row in the grid. Repeat this process to zoom in closer and closer.

To restore the graph to its normal, unzoomed state, select either the Restore option or the Zoom In option from the Graph menu, or click either the Restore toolbar button or the Zoom In toolbar button to exit “zoom mode”. The check mark is then removed from the Zoom In menu option and the Zoom In toolbar button no longer appears depressed.

### 7.5 Restore (Zoom Out)

Selecting the Restore option from the Graph menu exits “zoom mode” and restores the graph to displaying the entire trace. When “zoom mode” is exited, the mouse pointer no longer appears as a cross-hair when over the graph. The check mark is removed from the Zoom In menu option and the Zoom In toolbar button no longer appears depressed.

### 7.6 Print Graph

Selecting the Print Graph menu option prints the graph to the default printer. The graph can also be printed by selecting the Print | Graph option in the File menu or from the System tab of the Graph Settings dialog.

To select the current printer, use the Print Setup option in the File menu.

By default, the graph is printed with the following options (as found on the System tab of the Graph Settings dialog):

- Border is ON
- Orientation is set to the default printer’s orientation
- Full Page is ON

To print a graph using other than these default settings, use the System tab on the Graph Settings dialog.
8 Tools Menu

The Tools menu (Figure 45) provides utilities for setting various thermometer and probe parameters.

![Tools Menu](image)

**Figure 45  Tools Menu**

The Synchronize Date/Time menu option synchronizes the thermometer’s clock to the computer’s clock.

The Write Labels menu option can be used to change the labels associated with the logging features of selected thermometers.

The INFO-CON/Probe Settings menu option runs a utility that allows many probe-specific settings of the thermometer to be viewed and changed.

The Thermometer Settings menu option runs a utility that allows many thermometer parameters to be viewed and changed.

8.1 Synchronize Date/Time

The Synchronize Date/Time menu option synchronizes the thermometer’s clock to the computer’s clock. When this menu option is selected, the Select Model dialog is displayed (see Section 8.5). Select the thermometer model and communication settings to use and click the OK button.

If the selected thermometer requires the passcode to change the date and/or time, the Enter Passcode dialog is displayed (see Section 8.6). Enter the passcode for the thermometer and click the OK button.

**Note:** Entering an incorrect passcode will cause this function to fail to update the date and/or time properly.

The software then updates the date and/or time in the thermometer.
8.2 Write Labels

The Write Labels menu option can be used to change the labels associated with the logging features of selected thermometers. When this menu option is selected, the Select Model dialog is displayed (see Section 8.5). Select the thermometer model and communication settings to use and click the OK button.

**Note:** Currently, only the Model 1522 LLL Handheld Datalogger supports this feature.

After the thermometer is selected, the labels are read from the selected thermometer and displayed on the 1522 Data Labels dialog (Figure 46).

![1522 Data Labels](image)

*Figure 46  Data Labels Dialog*

**Current Labels**

The Current Labels list displays all of the labels currently in the thermometer. Use the scroll bar to scroll through the list.

**New Label**

To change the value of a label, click on the label to change. Enter the new value for the label in the New Label box. Each label can be up to 8 characters in length and can consist of any combination of alpha-numeric characters (A-Z and 0-9), the underscore (“_”), and dash (“-”) characters.

**Apply**

Clicking the Apply button changes the selected label to the value in the New Label box. The change is reflected in the Current Labels list.
Reset All

To reset all labels to their default settings, click the Reset All button. The default setting for each label is “LABELN” where N is the label number between 1 and the maximum number of labels.

Note: If there are any logged readings stored in the thermometer, it is recommended that the readings be downloaded BEFORE changing the labels!! When logging data, only the label number (or index) is stored with each reading, not the actual label value. Therefore, changing a label before downloading any logged readings also changes the labels associated with the readings.

Click the OK button to write the new label settings back to the thermometer.

Click the Cancel button to discard any changes you have made. The labels will NOT be written back to the thermometer.

Click the Help button to display the help topic for this dialog.

8.3 INFO-CON/Probe Settings

The INFO-CON/Probe Settings menu option runs a utility that allows many probe-specific settings of the thermometer to be viewed and changed. When this menu option is selected, the Select Model dialog is displayed (see Section 8.5). Select the thermometer model and communication settings to use and click the OK button.

After the thermometer is selected, the thermometer and channel-specific
settings are read from the selected thermometer and displayed on the Channel Settings dialog (Figure 47).

![Channel Settings Dialog](image)

**Figure 47** Channel Settings Dialog

The available channel settings vary from one thermometer to another. Only settings that are applicable to the selected thermometer are enabled.

**Note:** All items marked in RED require a valid passcode to be entered before they can be written to the thermometer. If a valid passcode is not entered, these settings will NOT be written to the thermometer.

Please refer to the User Guide that came with the thermometer for more details on each of these settings.

**Excitation Current**

The excitation current drop down list allows the excitation current used by the thermometer to be changed. The list contains only settings applicable to the selected thermometer.

**INFO-CON Settings**

For thermometers that use Hart's INFO-CON connectors, this utility allows the settings stored in the INFO-CON connector to be changed.
When written back to the thermometer, the changes are written to the INFO-CON connector.

**Probe Serial Number**

The Probe Serial Number box indicates the value stored in the INFO-CON connector as the serial number of the attached probe.

The Probe Serial Number can be up to 10 characters long (more characters are ignored) and can consist of any combination of the following characters:

- “0” to “9”
- “a” to “z”
- “A” to “Z”
- “-” (dash), “/” (slash) and “.” (period)

**Probe Wires**

The Probe Wires drop down list allows the user to select how the probe wires are connected to the INFO-CON connector or thermometer. The list contains only settings applicable to the selected thermometer.

**Probe Calibration**

The Probe Calibration section allows the parameters specific to the calibration of the attached probe to be changed.

**Calibration Date**

The Calibration Date indicates the date on which the attached probe was last calibrated. When a probe goes out of calibration (the Due Date passes), the probe should be recalibrated and the new calibration date, due date, and conversion coefficients should be entered.

To set the calibration date, click the down arrow on the right side of the
A calendar is displayed (Figure 48) with the current calibration date highlighted.

Select the calibration date using the calendar. To change months, click the left and right arrow buttons on the far left and right sides. To change the year, click on the displayed year at the top of the calendar and the up/down buttons will appear immediately to the right of the year. Use the up and down buttons to change the year. To select the day, simply click on the appropriate number on the calendar. The selected date is then displayed in the Calibration Date box.

**Due Date**

The Due Date indicates the date on which the calibration for the attached probe expires. When the probe is recalibrated, the new calibration date, due date, and conversion coefficients should be entered.

To set the due date, click the down arrow on the right side of the box. A calendar is displayed with the current due date highlighted. Follow the instructions above to select the new due date.

**Note:** The Due Date must always be after the Calibration Date. Otherwise, the software will not allow the dates to be written to the thermometer.

**Conversion Type**

The Conversion Type drop down list indicates the currently selected conversion type for the attached probe. When a probe is calibrated, a Report of Calibration is created which indicates the type of conversion and the conversion coefficients that should be programmed into the thermometer.
Determine the conversion type required for the attached probe and select the appropriate item from the drop down list. Only conversion types that are applicable to the selected thermometer are displayed in the list.

**Note:** If the conversion type required by the probe does not appear in the list, the probe may need to be recalibrated using one of the available conversion types.

**Conversion Settings**

Many conversion types require coefficients to be entered. If the selected conversion type does require coefficients to be entered, the Conversion Settings button is enabled. To enter probe coefficients, click the Conversion Settings button.

The appropriate conversion settings dialog is displayed. Enter the coefficients found on the probe's Report of Calibration and click the OK button on the conversion settings dialog to return.

This software supports the following types of conversions:

- ITS-90 (see ITS-90 Coefficients )
- IPTS-68 (see IPTS-68 Coefficients )
- Callendar-Van Dusen (see Callendar-Van Dusen Coefficients )
- High Temp. PRT (see High Temp. PRT Coefficients )
- Thermistor (see Thermistor Coefficients )
- YSI-400 (see YSI-400 Coefficients )
- IEC-751 (see IEC-751 Coefficients )

**Open and Save As**

Click the Open button to display the Windows® Open dialog to open a previously saved configuration file which contains channel information. Click the Save As button to display the Windows® Save As dialog to save the current settings you have selected to a configuration file.

**Note:** For more information on configuration files, see Section 11 Configuration Files.

Click the OK button to accept the current settings and close this dialog. The new settings will be written to the thermometer. If the selected thermometer requires the passcode to change any of the channel settings, the Enter Passcode dialog is displayed (see Section 8.6). Enter the passcode for the thermometer and click the OK button.
Note: Entering an incorrect passcode will cause this function to fail to update the channel settings properly.

Click the Cancel button to discard any changes you have made.

Click the Help button to display the appropriate help topic for this dialog.

8.4 Thermometer Settings

The Thermometer Settings menu option runs a utility that allows many thermometer-specific settings of to be viewed and changed. When this menu option is selected, the Select Model dialog is displayed (see Section 8.5). Select the thermometer model and communication settings to use and click the OK button.

After the thermometer is selected, the thermometer settings are read from the selected thermometer and displayed on the Thermometer Settings dialog (Figure 49). The channel-specific settings are also read in.

![Thermometer Settings](image)

*Figure 49* Thermometer Settings
The available thermometer settings vary from one thermometer to another. Only settings that are applicable to the selected thermometer are enabled.

**Note:** All items marked in RED require a valid passcode to be entered before they can be written to the thermometer. If a valid passcode is not entered, these settings will NOT be written to the thermometer.

Please refer to the User Guide that came with the thermometer for more details on each of these settings.

**Model**

The Model box indicates the currently selected thermometer model number. This setting cannot be changed.

**Serial Number**

The Serial Number box indicates the serial number of the currently selected thermometer. This setting cannot be changed. If the serial number could not be read from the thermometer, this box displays “<unknown>”.

**Firmware**

The Firmware box contains information about the firmware installed in the currently selected thermometer. This setting cannot be changed. If the firmware information could not be read from the thermometer, this box displays “<unknown>”.

**Units**

The Units drop down list indicates the currently selected units and allows the units to be changed. The available units varies from one thermometer to another.

**Filter**

The Filter box indicates the current filter setting in the thermometer. The filter value can be changed either by typing the new value into the box or by using the up/down buttons on the right side of the box. The allowable range of the filter setting varies from one thermometer to another.

**Resolution**

The Resolution drop down list indicates the current resolution setting in the thermometer. To change the resolution, choose a new setting from
the drop down list. Only settings that are applicable to the selected thermometer appear in the list.

**Thermometer Calibration**

The Thermometer Calibration section allows the parameters specific to the calibration of the thermometer to be changed.

**Calibration Constants**

The Calibration Constants indicate the current settings of the calibration constants of the thermometer. These constants are only set when the thermometer is calibrated and should not be changed until the thermometer itself is calibrated again. When a thermometer is calibrated, a Report of Calibration is created which indicates the values of these constants.

**Calibration Date**

The Calibration Date indicates the date on which the thermometer was last calibrated. When a thermometer goes out of calibration (the Due Date passes), the thermometer should be recalibrated and the new calibration date, due date, and calibration constants should be entered.

To set the calibration date, click the down arrow on the right side of the box. A calendar (Figure 48) is displayed with the current calibration date highlighted.

Select the calibration date using the calendar. To change months, click the left and right arrow buttons on the far left and right sides. To change the year, click on the displayed year at the top of the calendar and the up/down buttons will appear immediately to the right of the year. Use the up and down buttons to change the year. To select the day, simply click on the appropriate number on the calendar. The selected date is then displayed in the Calibration Date box.

**Due Date**

The Due Date indicates the date on which the calibration for the thermometer expires. When the thermometer is recalibrated, the new calibration date, due date, and calibration constants should be entered.

To set the due date, click the down arrow on the right side of the box. A calendar is displayed with the current due date highlighted. Follow the instructions above to select the new due date.
**Note:** The Due Date must always be after the Calibration Date. Otherwise, the software will not allow the dates to be written to the thermometer.

**Channel Settings**

The Channel Settings section displays a list of all channels on the selected thermometer. Currently, this software only supports single-channel thermometers.

**Channels**

The Channels list shows an entry for each channel on the selected thermometer numbered 1) to \( N \) where \( N \) is the total number of channels on the thermometer.

**Channel Settings**

To change the channel settings, select a channel from the Channels list and click the Channel Settings button. The Channel Settings dialog is displayed. For more information on the channel settings, see Section 8.3, the INFO-CON/Probe Settings.

**Open and Save As**

Click the Open button to display the Windows® Open dialog to open a previously saved configuration file which contains thermometer information, including the settings for all channels. Click the Save As button to display the Windows® Save As dialog to save the current settings you have selected to a configuration file.

**Note:** For more information on configuration files, see Section 11 Configuration Files.

Click the OK button to accept the current settings and close this dialog. The new settings will be written to the thermometer. If the selected thermometer requires the passcode to change any of the thermometer or channel settings, the Enter Passcode dialog is displayed (see Section 8.6). Enter the passcode for the thermometer and click the OK button.

**Note:** Entering an incorrect passcode will cause this function to fail to update the thermometer and channel settings properly.

Click the Cancel button to discard any changes you have made.

Click the Help button to display the appropriate help topic for this dialog.
8.5 Select Model

The Select Model dialog (Figure 50) allows the thermometer model and communication settings to be selected.

![Select Model Dialog](image)

**Model**

Select the model of the thermometer to use. Only thermometers that support the feature to be accessed are listed in the drop down list.

**COM port**

Select the COM port to which the thermometer is connected. This software expects to communicate with the thermometer via an RS-232 serial connection. Most laptop and desktop computers have at least one 9-pin or 25-pin COM port. Refer to your computer’s owners manual if you are unable to locate or identify a COM port on your computer.

**Note:** All Hart Scientific instruments require a “null modem” cable to interface with a computer. Please refer to the thermometer’s User Guide for more information on this type of cable.

Each COM port is accompanied by a symbol that reflects the current state of the COM port as follows:

- ![Symbol](image) - COM ports with this symbol are available on this computer and can be selected.

- ![Symbol](image) - COM ports with this symbol are virtual COM ports used to interface with an I/R port. This software does not support using COM ports with this associated symbol.
- The COM port with this symbol is currently being used by this software.

- COM ports with this symbol are in use by another application and cannot be used by this software at this time.

Baud Rate

Select the baud rate that should be used to communicate with the thermometer. The available choices are determined by the baud rates supported by the selected thermometer.

Note: The thermometer and this software must both be set to the same baud rate in order to communicate successfully. Please refer to the thermometer’s User Guide for more information on setting the baud rate of the thermometer.

Use I/R Dongle

If the Use I/R Dongle check box appears, the selected feature allows the use of an I/R dongle for communication. Using an I/R dongle can greatly increase the speed of communication, therefore reducing the amount of time to send and receive data to and from the thermometer. Check this option if an I/R dongle is being used. When this box is checked, the baud rate setting explained above is ignored.

For more information on using the I/R dongle, see Using an I/R dongle with LogWare.

Note: This software does not support the use of built-in I/R ports. To purchase an I/R dongle that is compatible with this software, contact Technical Support.

Test Communication

Once the model and communication settings have been selected, click the Test Communication button to attempt to establish communication with the thermometer and verify that the proper thermometer model is selected. If the software succeeds in communicating, a success message is displayed.

If the software is not able to successfully establish communication with the thermometer or if the software determines that the selected model does not match the model of the connected thermometer, a failure message is displayed indicating the reason for the failure. In case of failure, check to make sure that:
8 Tools Menu

- The communication cable is connected to the thermometer and the selected COM port
- The thermometer is powered up and operating
- The correct type of cable (null modem) is being used
- The thermometer is set to operate at the selected baud rate
- If using the I/R dongle, make sure the dongle is in range of the I/R port on the thermometer

Click the OK button to close this dialog and continue.
Click the Cancel button to close this dialog without continuing.
Click the Help button to display the help topic for this dialog.

8.6 Enter Passcode

The Enter Passcode dialog (Figure 51) appears when writing new settings to thermometers that have some passcode protected settings. These settings are generally calibration related settings such as the conversion type, conversion coefficients, calibration and recalibration dates, etc.

To update the thermometer with the settings entered into this software, enter the passcode for the connected thermometer and click the OK button.

LogWare attempts to validate the passcode on thermometers which support this feature. Currently, only the 1522 LLL Handheld Datalogger supports passcode validation. If the passcode entered is invalid or was not typed correctly, the software will display the Enter Passcode prompt again. Re-enter the passcode or click the Cancel button to abort.
For thermometers that do not support passcode validation, the software has no way of determining whether the passcode entered is valid or not. LogWare will attempt to write the changes to the thermometer. If the passcode was correct, the changes will be successfully written to the thermometer. Otherwise, the changes will not be successfully written to the thermometer.

### 8.7 Callendar-Van Dusen Coefficients

When the conversion type on the Channel Settings dialog is set to Callendar-Van Dusen and the Conversion Settings button is clicked, the Callendar-Van Dusen Coefficients dialog is displayed (Figure 52).

![Figure 52 Callendar-Van Dusen Coefficients Dialog](image)

**R0, ALPHA, DELTA and BETA**

The R0, ALPHA, DELTA, and BETA coefficients (as applicable) are required and must be entered. Enter the R0, ALPHA, DELTA, and BETA coefficients from the Report of Calibration for the probe attached to the selected channel. Only coefficients that are supported by the selected thermometer are visible.

If the Callendar-Van Dusen coefficients were read in from the thermometer, the boxes are filled with the current coefficients. If the value of any of the coefficients is 0, the box is left blank.

**Open and Save As**

Click the Open button to display the Windows® Open dialog to open a previously saved configuration file which contains Callendar-Van Dusen...
coefficients. Click the Save As button to display the Windows® Save As dialog to save the settings you have selected to a configuration file.

**Note:** For more information on configuration files, see Section 11 Configuration Files.

Click the OK button to accept the current settings and close this dialog. Click the Cancel button to discard any changes you have made. Click the Help button to display the appropriate help topic for this dialog.

### 8.8 High Temp. PRT Coefficients

When the conversion type on the Channel Settings dialog is set to High Temp. PRT and the Conversion Settings button is clicked, the High Temp. PRT Coefficients dialog (Figure 53) is displayed.

#### RTPW, A and B

The RTPW, A and B coefficients are required and must be entered. Enter the RTPW, A and B from the Report of Calibration for the probe attached to the selected channel.

If the High Temp. PRT coefficients were read in from the thermometer, the boxes are filled with the current coefficients. If the value of any of the coefficients is 0, the box is left blank.

#### Open and Save As

Click the Open button to display the Windows® Open dialog to open a previously saved configuration file which contains High Temp. PRT coeffi-
When the conversion type on the Channel Settings dialog is set to IPTS-68 and the Conversion Settings button is clicked, the IPTS-68 Coefficients dialog (Figure 54) is displayed.

Scale
Select the temperature scale for the selected channel. If ITS-90 is selected, the temperature is adjusted by a small amount equal to the difference between the ITS-90 and IPTS-68 temperature scales. See the thermometer User Guide for more details on setting this option.
R0, ALPHA, DELTA, A4 and C4

The R0, ALPHA, DELTA, A4, and C4 coefficients are required and must be entered. Enter the R0, ALPHA, DELTA, A4, and B4 coefficients from the Report of Calibration for the probe attached to the selected channel.

If the IPTS-68 coefficients were read in from the thermometer, the boxes are filled with the current coefficients. If the value of any of the coefficients is 0, the box is left blank.

Open and Save As

Click the Open button to display the Windows® Open dialog to open a previously saved configuration file which contains IPTS-68 coefficients. Click the Save As button to display the Windows® Save As dialog to save the settings you have selected to a configuration file.

Note: For more information on configuration files, see Section 11 Configuration Files.

Click the OK button to accept the current settings and close this dialog. Click the Cancel button to discard any changes you have made. Click the Help button to display the appropriate help topic for this dialog.

8.10 ITS-90 Coefficients

When the conversion type on the Channel Settings dialog is set to
ITS-90 and the Conversion Settings button is clicked, the ITS-90 Coefficients dialog (Figure 55) is displayed.

![ITS-90 Coefficients Dialog]

**Figure 55**  ITS-90 Coefficients Dialog

**RTPW**

The RTPW coefficient is required and must be entered. Enter the RTPW value from the Report of Calibration for the probe attached to the selected channel.

**Low Range**

Select the Low Range tab to enter values for the low range coefficients. The a and b coefficients are required and must be entered. Enter the a and b values from the Report of Calibration for the probe attached to the selected channel. If no low range is being used or the Report of Calibration does not have low range coefficients, enter 0 for both a and b coefficients.
High Range

Select the High Range tab to enter values for the high range coefficients. The a, b, c and d coefficients are required and must be entered. Enter the a, b, c and d values from the Report of Calibration for the probe attached to the selected channel. If no high range is being used or the Report of Calibration does not have one or more high range coefficients, enter 0 for all missing coefficients.

If the ITS-90 coefficients were read in from the thermometer, the boxes are filled with the current coefficients. If the value of any of the coefficients is 0, the box is left blank.

Open and Save As

Click the Open button to display the Windows® Open dialog to open a previously saved configuration file which contains ITS-90 coefficients. Click the Save As button to display the Windows® Save As dialog to save the settings you have selected to a configuration file.

Note: For more information on configuration files, see Section 11 Configuration Files.

Click the OK button to accept the current settings and close this dialog.

Click the Cancel button to discard any changes you have made.

Click the Help button to display the appropriate help topic for this dialog.

8.11 Thermistor Coefficients

When the conversion type on the Channel Settings dialog is set to
Thermistor and the Conversion Settings button is clicked, the Thermistor Coefficients dialog is displayed (Figure 56).

![Thermistor Coefficients Dialog](image)

**Figure 56**  Thermistor Coefficients Dialog

**B0, B1, B2 and B3**

The B0, B1, B2, and B3 coefficients are required and must be entered. Enter the B0, B1, B2, and B3 coefficients from the Report of Calibration for the probe attached to the selected channel.

If the Thermistor coefficients were read in from the thermometer, the boxes are filled with the current coefficients. If the value of any of the coefficients is 0, the box is left blank.

**Open and Save As**

Click the Open button to display the Windows® Open dialog to open a previously saved configuration file which contains Thermistor coefficients. Click the Save As button to display the Windows® Save As dialog to save the settings you have selected to a configuration file.

**Note:** For more information on configuration files, see Section 11 Configuration Files.

Click the OK button to accept the current settings and close this dialog.

Click the Cancel button to discard any changes you have made.

Click the Help button to display the appropriate help topic for this dialog.
9 Window Menu

The Window menu (Figure 57) provides options for manipulating all of the open windows.

**Figure 57  Window Menu**

- **Cascade**
  The Cascade option cascades all open windows on the main display so that the title bar of each window is visible.

- **Tile Horizontal**
  The Tile Horizontal option arranges all open windows horizontally on the main display.

- **Tile Vertical**
  The Tile Vertical option arranges all open windows vertically on the main display.

- **Arrange Icons**
  The Arrange Icons option arranges all of the icons for the windows that are currently minimized on the main display.

- **List of Open Windows**
  The bottom part of the Window menu lists all of the open windows and shows a check mark next to the currently active window. Clicking on the desired menu item can activate any of the windows listed.
10 Help Menu

The Help menu (Figure 58) provides options for displaying the help file, technical support information, and version information about the LogWare software.

![Figure 58 Help Menu](image)

10.1 Technical Support

Technical support can be obtained by calling or faxing Hart Scientific Technical Support:

- Phone: (801) 763-1600
- Toll Free: 1-800-GET-HART (1-800-438-4278)
- Fax: (801) 763-1010
- E-mail: support@hartscientific.com

Internet: [http://www.hartscientific.com](http://www.hartscientific.com) (Check our website on the Internet regularly for answers to Frequently Asked Questions, updates, and Service Releases.)

Before calling Technical Support, check the topics listed below to see if the problem you are having is described there.

- Requirements (see Section 1.3)
- Installation (see Section 1.4)
- Running LogWare (see Section 1.6)
- Required .DLL and .OCX Files (see Section 1.7)
- Regional Settings (See Section 1.5)
- How to… topics (see Section 2)

When calling or sending a fax, please send or have the following information ready:
10 Help Menu

- Name of the software
- Software version (as found on the Help|About dialog)
- Detailed description of the problem
- What you were doing when the problem arose
- The exact wording of the error message you received
- Any other information that may help to solve the problem

10.2 About

The About 9934 LogWare dialog (Figure 59) displays specific information about the software.

![About 9934 LogWare Dialog](image)

*Figure 59* About 9934 LogWare Dialog

The information on this dialog includes:

- Software Icon
- Software Model Number
- Software Name
- Software Version
- Software Information
11 Configuration and Other Files

The 9934 LogWare software supports multiple types of configuration files. Configuration files are intended to facilitate the configuration process. By default, all configuration files are saved to the \CONFIG folder (see Section 3.4.2) which was created when the software was installed.

**WARNING:** Do not attempt to manually modify the contents of any of the configuration files! Files that have been modified by any other means than being saved by this software may cause unpredictable results!

The different types of configuration files are:

- Single Channel configuration file
- Alarms configuration file
- Thermometer configuration file
- Channel configuration file
- Conversion configuration file

Each type of configuration file is explained below:

11.1 Single Channel Configuration File

Single Channel configuration files contain ALL configuration information required to start a real-time log session. This information includes the thermometer information, communication settings, sample interval settings, channel and alarm settings.

Single Channel configuration files **must always** have an extension of .scc and can be saved and opened from any of the following locations:

- Log Session Settings dialog
- File | Open and Save As Menu Options and toolbar buttons

**Note:** Opening a Single Channel configuration file overwrites ALL current settings related to real-time log session configuration.

11.2 Alarms Configuration File

Alarms configuration files contain configuration information for the alarms. This information includes the low alarm and high alarm values, events, and other options.
Alarms configuration files **must always** have an extension of `.als` and can be opened or saved from the Alarm Settings dialog which is accessible from the Log Session Settings dialog by clicking the Alarm Settings button. To display the Log Session Settings dialog, select the Setup option from the Datalog menu.

**Note:** Opening an Alarms configuration file overwrites the current alarm settings on the selected channel.

### 11.3 Thermometer Configuration File

Thermometer configuration files are useful for saving the current thermometer settings to a file. Thermometer configuration files contain the thermometer serial number, units, filter, resolution, calibration constants and dates and all of the information that is included in the Channel and Conversion configuration files explained below.

Thermometer configuration files **must always** have an extension of `.thm` and can be saved or opened from the Thermometer Settings dialog which is accessible by selecting the Thermometer Settings option from the Tools menu.

**Note:** Opening a Thermometer configuration file overwrites the current thermometer, channel, conversion and coefficient settings.

### 11.4 Channel Configuration File

Channel configuration files are useful for saving the current channel and/or INFO-CON settings to a file. Channel configuration files contain only configuration information concerning a single channel of the thermometer. This information includes the excitation current, probe serial number, probe wires, probe calibration dates, probe conversion type and all of the information that is included in the Conversion configuration files explained below.

Channel configuration files **must always** have an extension of `.chn` and can be saved or opened from the Channel Settings dialog which is accessible by selecting the INFO-CON/Probe Settings option from the Tools menu.

**Note:** Opening a Channel configuration file overwrites the current channel, conversion and coefficient settings.

### 11.5 Conversion Configuration Files

Conversion configuration files are useful for saving the current probe coefficients to a file. Conversion configuration files contain information con-
cerning a single conversion type including coefficients and any other information specific to the conversion type.

Conversion configuration files have an extension that matches the type of conversion as detailed below:

Table 2 Conversion Types

<table>
<thead>
<tr>
<th>Conversion Type</th>
<th>File Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Callendar-Van Dusen</td>
<td>.cvd</td>
</tr>
<tr>
<td>High Temp. PRT</td>
<td>.htp</td>
</tr>
<tr>
<td>IPTS-68</td>
<td>.i68</td>
</tr>
<tr>
<td>ITS-90</td>
<td>.i90</td>
</tr>
<tr>
<td>Thermistor</td>
<td>.thr</td>
</tr>
<tr>
<td>IEC-751</td>
<td>N/A (cannot be saved)</td>
</tr>
<tr>
<td>YSI-400</td>
<td>N/A (cannot be saved)</td>
</tr>
</tbody>
</table>

Conversion configuration files can be opened from the following locations:

- Callendar-Van Dusen Coefficients dialog (see Section 8.7)
- High-Temp. PRT Coefficients dialog (see Section 8.8)
- IPTS-68 Coefficients dialog (see Section 8.9)
- ITS-90 Coefficients dialog (see Section 8.10)
- Thermistor Coefficients dialog (see Section 8.11)

**Note:** Opening a Conversion configuration file overwrites the conversion settings on the selected channel!!

### 11.6 Output Files

LogWare saves the readings logged during a real-time log session to an output file. Output files also contain information about the thermometer, channel (probe), and alarm settings that were configured for the log session.

During a real-time log session, the logged readings are displayed in the Channels grid (current reading only) and graphed on the real-time graph. To view all of the readings that have been logged, select the Readings History option from the View menu. This opens the output file for the selected channel in a spreadsheet-style grid.
After a real-time log session has been stopped and/or closed, the output file can be opened by selecting the Open Previously Logged Data File option from the View menu. All of the readings that were logged are displayed in a spreadsheet-style grid and on the graph. Output files can also be opened in other analysis software packages such as spreadsheets and text editors.

The format of an output file is as follows:

```
Channel 1.txt
Thermometer Model: 1502 Serial: 12345  Readings Scale: °C
Probe: Channel 1
Low Alarm: 21.000 °C  High Alarm: 22.000 °C

+-----------------+----------+-----------------+---------+
<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Reading</th>
<th>Alarm</th>
</tr>
</thead>
<tbody>
<tr>
<td>12/13/1999</td>
<td>11:11:57 AM</td>
<td>25.468 °C</td>
<td>High</td>
</tr>
<tr>
<td>12/13/1999</td>
<td>11:12:00 AM</td>
<td>25.468 °C</td>
<td>High</td>
</tr>
<tr>
<td>12/13/1999</td>
<td>11:12:01 AM</td>
<td>25.469 °C</td>
<td>High</td>
</tr>
<tr>
<td>12/13/1999</td>
<td>11:12:02 AM</td>
<td>25.469 °C</td>
<td>High</td>
</tr>
<tr>
<td>12/13/1999</td>
<td>11:12:03 AM</td>
<td>25.469 °C</td>
<td>High</td>
</tr>
<tr>
<td>12/13/1999</td>
<td>11:12:04 AM</td>
<td>25.469 °C</td>
<td>High</td>
</tr>
<tr>
<td>12/13/1999</td>
<td>11:12:05 AM</td>
<td>25.470 °C</td>
<td>High</td>
</tr>
<tr>
<td>12/13/1999</td>
<td>11:12:06 AM</td>
<td>25.469 °C</td>
<td>High</td>
</tr>
<tr>
<td>12/13/1999</td>
<td>11:12:07 AM</td>
<td>25.469 °C</td>
<td>High</td>
</tr>
<tr>
<td>12/13/1999</td>
<td>11:12:08 AM</td>
<td>25.469 °C</td>
<td>High</td>
</tr>
<tr>
<td>12/13/1999</td>
<td>11:12:09 AM</td>
<td>25.469 °C</td>
<td>High</td>
</tr>
<tr>
<td>12/13/1999</td>
<td>11:12:10 AM</td>
<td>25.469 °C</td>
<td>High</td>
</tr>
</tbody>
</table>
```

**Figure 60 Example Output File**

### 11.7 Download Files

LogWare includes a feature that allows readings that are stored in the memory of thermometers that support this feature to be downloaded and written into text files, called download files.

Currently, only the model 1522 LLL Handheld Datalogger thermometer supports this feature. To download readings from a 1522 LLL Handheld Datalogger, see the Download Logged Data option in the Download menu. Also, please read Section 5.4 Binary Download Discrepancies.

Download files can be opened by this software by selecting the Open Previously Logged Data Files option from the View menu. They can also be opened in other analysis software packages such as spreadsheets and text editors.

The format of a download file is very similar to and follows the same general format as an output file (readings logged by this software). The download files, however, do not contain any thermometer, channel...
(probe) or alarm information since the software does not know any of this information. See the example below:

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Reading</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>12/08/1999</td>
<td>10:46:16 AM</td>
<td>-40.29424 °C</td>
<td>BATH1</td>
</tr>
<tr>
<td>12/08/1999</td>
<td>10:46:17 AM</td>
<td>-40.27832 °C</td>
<td>BATH1</td>
</tr>
<tr>
<td>12/08/1999</td>
<td>10:46:18 AM</td>
<td>-40.28952 °C</td>
<td>BATH1</td>
</tr>
<tr>
<td>12/08/1999</td>
<td>10:46:19 AM</td>
<td>-40.27979 °C</td>
<td>BATH1</td>
</tr>
<tr>
<td>12/08/1999</td>
<td>10:46:20 AM</td>
<td>-40.29018 °C</td>
<td>BATH1</td>
</tr>
<tr>
<td>12/08/1999</td>
<td>10:46:21 AM</td>
<td>-40.29193 °C</td>
<td>BATH1</td>
</tr>
<tr>
<td>12/08/1999</td>
<td>10:46:22 AM</td>
<td>-40.28961 °C</td>
<td>BATH1</td>
</tr>
</tbody>
</table>

**Figure 61**  Example Download File

11.8 **Alarm Log File**

When a real-time log session is started, the software creates a file in the same folder as the output files called “alarms.log”. The purpose of this file is to maintain a history of readings that caused the alarms to trip or reset.

The format of an alarm log file is as follows:

<table>
<thead>
<tr>
<th>Alarm.log</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Settings: High Alarm: 29.000</td>
</tr>
<tr>
<td>Channel 2</td>
</tr>
<tr>
<td>Date</td>
</tr>
<tr>
<td>12/10/1999</td>
</tr>
<tr>
<td>12/10/1999</td>
</tr>
<tr>
<td>12/10/1999</td>
</tr>
</tbody>
</table>

**Figure 62**  Example Alarm Log File

The alarm log file can be viewed during a real-time log session by selecting the Alarm Log menu option from the View menu or by right-clicking on the Channels grid on the Real-Time Log Session window and selecting View Alarm Log from the popup menu.
Index

A
A, 106
A4, 108
About, 116
alarm, 44, 49
alarm log, 44, 64
alarm log file, 44, 51, 63, 121
alarms, 41, 43, 65
ALPHA, 105, 108
Arrange Icons, 113
ASCII, 54, 61
autolog, 54, 59
axis, 75

B
B, 106
B0, 111
B1, 111
B2, 111
B3, 111
background, 83
baud rate, 39, 61, 103
BETA, 105
binary, 54, 61
Binary Download Discrepancies, 61
BMP, 87
border, 86
bottom title, 74

C
C4, 108
calendar, 47, 96, 100
calibration, 23 - 24, 95
calibration constants, 23, 100
calibration date, 95 - 96, 100
Callendar-Van Dusen, 97, 105
Cascade, 113
channel, 40, 94, 101, 105 - 107, 109, 111
Clear Log, 59
Clipboard, 87
clock, 26, 47, 91
Close, 43
coefficients, 23 - 24, 97, 105 - 106, 108 - 109, 111
color, 81, 84
COM port, 102
communication, 39, 59, 103
Communications Requirements, 3
configuration, 17, 31
Conversion, 105
correction coefficients, 95 - 96
correction type, 23 - 24, 96, 106 - 108, 110
Copy, 87
current, 94
Curve Fit, 80
customize, 88
Datalog Toolbar, 13
date, 23 - 24, 26, 47, 91
default configuration, 41
default configuration file, 18, 34, 41
default settings, 88
Defaults, 18, 32
Delayed Start, 19, 40, 42, 47
DELTA, 105, 108
demand log, 54, 58 - 59
dongle, 15
download, 21, 53, 59
download files, 35, 56 - 57, 63, 67, 120
download mode, 54
due date, 95 - 96, 100

Elapsed Time, 51, 68
E-mail, 115
End Log, 20, 39
event, 45
excitation current, 94
Exit, 36
export, 87

Fax, 115
features, 1
File menu, 31
File Options, 56
File Toolbar, 12
Filter, 23, 99
Firmware, 99
Folders, 34
Fonts, 78

Getting Started, 6
Graph, 36, 51, 69, 71, 74
Graph Settings, 51, 72
Graph Template, 88
Graph Title, 74
Graph Toolbar, 13
Graph Window, 84
Grids, 77

Hardware, 3
Help, 115
Help Toolbar, 14
High Alarm, 44, 82
High Range, 110
High Temp. PRT, 97, 106
How to, 15
HTML, 88

I/R dongle, 54, 103
I/R ports, 15
IEC-751, 97
ignore, 41
Import, 27
INFO-CON, 23, 91, 93 - 94
installing, 4
Internet, 115
IPTS-68, 97, 107
ITS-90, 97, 107, 109

JPEG, 87

labels, 59, 91 - 92
landscape, 87
latency, 40, 42, 48
Launch .EXE file, 45
Left Title, 74
Legend, 85
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit Lines, 81</td>
</tr>
<tr>
<td>Log Status, 22, 58</td>
</tr>
<tr>
<td>Low Alarm, 44, 82</td>
</tr>
<tr>
<td>Low Range, 109</td>
</tr>
</tbody>
</table>

**M**

- main display, 11
- map file, 87
- Model, 102
- Mono, 86
- Mute, 43

**N**

- New, 31
- null modem, 38, 102

**O**

- operating systems, 3
- Orientation, 90
- output file, 36, 40, 66 - 67, 119 - 120
- output files, 35, 63, 67
- overwrite, 41, 57

**P**

- Palette, 84
- passcode, 91, 97, 99, 101, 104
- Phone, 115
- Play .WAV file, 45
- PNG, 87
- polynomial, 81
- portrait, 87
- position, 85
- print, 36, 64
- Print Graph, 69, 87, 90
- Print Setup, 35
- printer, 35 - 36
- probe, 23, 93, 95

- sample rate, 39, 50
- Save, 88
- Save As, 32, 41, 46, 97, 101, 106 - 108, 110 - 111
- Scale, 76, 107
- serial number, 23 - 24, 95, 99
- settings, 23
- Setup, 37
- Shared Files Conflict, 8
- Size, 78, 86
- spreadsheet, 27
- Start, 42
- Statistical Lines, 79
- statistics, 41, 51, 67 - 68
- Status Bar, 63
- Stop, 43
- Style, 83
- synchronize, 26, 91
Technical Support, 115
template file, 88
Thermistor, 97, 111
thermometer, 2, 23, 98
Thermometer Calibration, 100
Tick Marks, 77
Tile Horizontal, 113
Tile Vertical, 113
time, 26, 47, 91
titles, 73
toolbar, 12, 63
Tools, 91
Tools Toolbar, 13
Trace Color, 40, 69, 89
Trends, 79
Typeface, 78

uncertainty, 62
Uninstall, 5
Units, 99

View, 63

Window, 113
Windows® 95/98, 3
Windows® NT, 3
wires, 23 - 24, 95
WMF, 87

X-axis, 69, 76

Y-axis, 69, 76
YSI-400, 97
Zoom In, 89 - 90